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Measurement with Option 

Measurement with Options 

The following measurement is available depending on the installed option. 
See the Activating Software Option for activating option. 

 Frequency Offset Measurement (Option 008) 

 Measurement Wizard Assistant (Option 790) 

 Enhanced Time Domain Analysis (Option TDR) 

 Time Domain Analysis (Option 010) 
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Frequency Offset Measurement 

Frequency Offset Measurement (Option 008) 

 Overview 

 Measurement of Harmonic Distortion 

 Measurement of Mixers 

Other topics about Measurement with Options 
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Overview 

 Introduction 

 Measurement consideration for mixers and frequency converter 
devices 

Other topics about Frequency Offset Measurement 

Introduction 

The E5071C option 008 provides a frequency-offset function and an 
absolute measurement function. 

Generally with network analyzers, the frequency must be the same both at 
the signal source and at the receiver, so frequency-translating devices 
such as mixers or converters cannot be measured. To enable the analyzer 
to measure frequency conversion devices, the receiver frequency must be 
synchronized with a frequency consisting of the input frequency and a 
certain added offset, which is called frequency-offset sweep. 

The E5071C option 008 provides not only this frequency-offset sweep but 
state-of-the-art mixer calibration features: vector-mixer calibration and 
scalar-mixer calibration. Vector-Mixer Calibration allows you to measure 
the conversion loss, phase, reflection parameter, and group delay of the 
mixer. Scalar-Mixer Calibration performs high-accuracy measurement for 
the magnitude and reflection parameter of mixer conversion loss. 

Moreover, the E5071C option 008 supports an absolute measurement 
function. The network analyzers normally measure the ratio of the test 
signal's magnitude and phase to the reference signal. In contrast, the 
absolute measurement function performs a measurement of the absolute 
value of the test signal's magnitude. In combination with the frequency-
offset function, the absolute measurement function provides 
measurements that include measurement of harmonic distortion. It also 
provides high-accuracy measurement when combined with Power 
Calibration and Receiver Calibration. 

 When you measure the 3rd harmonics over 8.5 GHz 
with options 2D5, 4D5, 2K5 and 4K5, it is recommended to 
suppress the carrier signal using filter etc before executing the 
measurement for accurate results. 

Measurement consideration for mixers and frequency converter devices 

In mixers and frequency converter devices measurements, you have RF 
and LO inputs and an IF output. Also appearing from the IF port are 
several other mixing products of the RF and LO signals. In mixers and 
frequency converter devices measurements, leakage signals from one 
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mixer port propagate and appear at the other two mixer ports. These 
unwanted mixing products or leakage signals can cause distortion by 
mixing with the harmonic of the analyzer’s first down-conversion stage and 
cause measurement error.  

To ensure successful mixer measurements, the following measurement 
challenges must be taken into consideration: 

Reducing the Effect of Spurious Responses 

 By choosing test frequencies (frequency list mode), 
you can reduce the effect of spurious responses on 
measurements by avoiding frequencies that produce IF signal 
path distortion.  To avoid frequency spacings equal to the 
analyzer’s IF is an important factor. In the case of the E5071C, 
the IF is 3 MHz and 3.25 MHz with fundamental mixing under 
8.5 GHz measurements, and 3rd harmonic mixing over 8.5 GHz 
measurements. Therefore, avoid the frequencies which meet the 
following formula. (*1) 
 
m ×RF ± n×LO = l × E5071C_Local ± 3 MHz or 3.25 MHz (m, 
n, l = 0, 1, 2 ...) 
where, E5071C_Local is 

 Measured Signal Frequency + 3 MHz or 3.25 
MHz   (Under 8.5 GHz) 

 1/3 × (Measured Signa Frequency + 3 MHz or 
3.25 MHz)   (Over 8.5 GHz) 
 
(*1): Except the target measuring frequency, that is 
m=n=1 
  

 Another effective technique is to reduce the 
instrument’s IF bandwidth. Reducing the IF bandwidth will more 
selectively filter signals in the instrument’s IF signal path. 

 If some spurious is inevitable, then one of the 
practical way is to neglect or delete the presumed frequency 
data. 

Eliminating Unwanted Mixing and Leakage Signals 

By placing filters between the mixer’s IF port and the receiver’s input port, 
you can eliminate unwanted mixing and leakage signals from entering the 
analyzer’s receiver. Filtering is required in both fixed and broadband 
measurements. Therefore, when configuring broad-band (swept) 
measurements, you may need to trade some measurement bandwidth for 
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the ability to more selectively filter signals that enters the analyzer 
receiver.  

Minimizing Source and Load Mismatches 

Source and load mismatches cause measurement error and will add to 
overall measurement uncertainty.  The E5071C’s scalar mixer calibration 
(SMC) or vector mixer calibration (VMC) removes the error caused by 
these mismatches.  

 Output power level calibration is not included in the SMC 
and VMC. An independent power calibration is required to apply 
power calibration. 

Example of Symptom 

This following figure shows an example of symptom. 

 
 In the configuration at the markers 1 and 3, the measured signal 

becomes 3 MHz. A signal leakage through the E5071C mixer affects 
the E5071C IF signal. 

 In the configuration at the marker 2, the 2nd harmonic of RF and IF is 
the same as the measured signal. A signal leakage of the 2nd 
harmonic through the mixier (DUT) affects the measured signal. (This 
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configuration is not a common usage. This is a mathematical example 
case to explain the symptom.) 

Marker 
No. in 
Example 
result 

RF 
(Port 
1)  

LO  
(from 
Signal 
Generator) 

Measured 
Signal 
(Port 2)   

E5071C_Local 
E5071C_ 
IF 

1 
497 
MHz 

500 MHz 

997 MHz 
and 3 MHz 1000 MHz 

3 MHz 2 
500 
MHz 

1000 MHz 
and DC 

1003 MHz 

3 
503 
MHz 

1003 MHz 
and 3MHz 

1006 MHz 

Signal Leakage through mixers 
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Measurement of Harmonic Distortion 

 Overview 

 Procedure 

Other topics about Frequency Offset Measurement 

Overview 

Using the frequency-offset function and absolute measurement function in 
combination allows you to measure harmonic distortion of nonlinear 
devices such as mixers and amplifiers. 

Procedure 

Item Description 

1. Setting Frequency-Offset Sets frequency-offset function 

2. Implementing Receiver Calibration Implements receiver calibration 

3. Setting Absolute Measurement 
Parameters 

Sets absolute measurement parameters 

 Procedures for setting absolute 
measurement parameters 

4. Harmonic Distortion Measurement 

Implements harmonic distortion 
measurement 

  Connection of DUT 

 Procedures for setting 
measurement parameters 

1. Setting Frequency-Offset Function 

The frequency-offset function allows you to make measurements while the 
frequencies are different at each test port. In this case, measurement is 
done by using the setting example for measurement frequency in the 
following figure. For the setting of frequency-offset sweep, see Setting 
Frequency-Offset. 
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 When you measure the 3rd harmonics over 8.5 GHz 
with options 2D5, 4D5, 2K5 and 4K5, it is recommended to 
suppress the carrier signal using filter etc before executing the 
measurement for accurate results. 

2. Implementing Receiver Calibration 

Receiver calibration is required for the absolute measurement. Receiver 
calibration of the port to be used for the measurement increases the 
accuracy in the absolute measurement. 

For detailed information on receiver calibration, see Receiver Calibration. 

3. Setting Absolute Measurement Parameters 

The frequency-offset function has an added absolute measurement 
function. 

Procedures for setting absolute measurement parameters 

Follow the steps below to set the absolute measurement parameters. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to implement absolute 
measurement. 

2. Press Meas key to display the Measurement Menu. 

3. Click Absolute to select measurement parameters. 
  

Softkey Function 

A (n) Absolute measurement in Port 1, test receiver 

B (n) Absolute measurement in Port 2, test receiver 
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C (n) Absolute measurement in Port 3, test receiver 

D (n) Absolute measurement in Port 4, test receiver 

R1 (n) Absolute measurement in Port 1, reference receiver 

R2 (n) Absolute measurement in Port 2, reference receiver 

R3 (n) Absolute measurement in Port 3, reference receiver 

R4 (n) Absolute measurement in Port 4, reference receiver 

n in the parentheses is the stimulus port number. 

4. Harmonic Distortion Measurement 

Harmonic distortion is a typical measurement parameter of nonlinear 
devices such as mixers and amplifiers. As shown in the following figure, 
the second and third distortions increase by square and cube values of the 
fundamental signal, respectively. Thus the distortion component increases 
as a function of the fundamental signal power, and the harmonic distortion 
can be measured as the proportion of the 2nd and 3rd harmonic power 
levels to the fundamental signal power level. 

 
  

Connection of DUT 

Connect the DUT as shown below. 
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Procedures for setting measurement parameters 

Follow the steps below to set the measurement parameters. In this case, 
we measure the harmonic distortion magnitude by using the frequency-
offset sweep and the absolute measurement function, based on the 
E5071C's internal signal source. 

 Receiver calibration is required before starting 
absolute measurement. For detailed information on receiver 
calibration, see Receiver Calibration. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to implement absolute 
measurement. 

2. Press Meas key to display the Measurement Menu. 

3. Press Absolute to select absolute measurement parameters (B (1)). 
Accordingly, the stimulus port and test port are set to 1 and 2, 
respectively. 

4. In this case, the segment sweep function is used to perform faster 
measurement. For detailed information on segment sweep, see 
Performing a Segment-by-Segment Sweep (segment sweep). 

5. Press Sweep Setup, then click Edit Segment Table to display the Edit 
Segment Table Menu. 
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6. Set Frequency Mode to Center/Span. Refer to the following table to 
input numbers in the segment table, and then press Return to return 
to the Sweep Setup Menu. 
  

Center Span Point 

500 MHz 0 Hz 1 

1 GHz 1 MHz 5 

2 GHz 1 MHz 5 

3 GHz 1 MHz 5 

3.5 GHz 0 Hz 1 

7. Set Segment Display to Freq Base. 

8. Press Sweep Type to select Segment. 

9. Press Scale key to use Auto Scale All for trace scale optimization. 
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10. If you use the network analyzer as a tuning receiver like a 
spectrum analyzer, the setting must be the same at both the 
frequency point at which the harmonic is generated and the 
measurement point. Spectrum analyzers can detect all of the 
signals residing in the range of sweep frequencies, but network 
analyzers can only detect the signals residing in the 
measurement frequency point. 

 For additional information about the absolute 
measurements, see Agilent application note 1463-6 Accurate 
Mixer Measurements Using the Frequency-Offset Mode, 5989-
1420EN (Internet Connection is required  to open). 
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Measurement of Mixers 

 Overview 

 Procedure 

Other topics about Frequency Offset Measurement 

Overview 

The frequency-offset function allows you to measure frequency-translating 
devices such as mixers. 

Procedure 

Item Description 

1. Setting Frequency-
Offset 

Sets frequency-offset 

 Procedures for setting frequency at each port 

 Procedures for enabling frequency-offset 
function 

2. Setting External Signal 
Source 

Sets external signal source (source of LO signal) 

 Preparations for controlling external signal 
source 

 Procedures for setting external signal source 
GPIB address 

 Procedures for selecting external signal source 

 Procedures for setting external signal source 
frequency 

 Procedures for setting external signal source 
power level 

 Procedures for controlling external signal source 

3. Changing Frequency 
Data 

Changes frequency data. 

 Procedures for changing frequency data 

4. Implementing Mixer 
Calibration 

Implements mixer calibration 

5. Conversion Loss 
Measurement 

Measures conversion loss of mixer 

 Connection of measured mixer 

 Procedures for setting measurement parameters 

 Procedures for changing measurement data 

1. Setting Frequency-Offset 
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The frequency-offset function allows you to implement the measurements 
in which frequencies are different for each port, such as in mixer 
measurement. The frequency set for each port can be applied to the port 
even if it is for stimulus or receiver. 

  You can set the frequency-offset for each channel 
independently. 

Procedures for setting frequency at each port 

The frequencies set at Port-n (n: any port number) should be a multiplier 
(Mn), divisor (Dn) and offset (On) for the basic frequency setting shown in 
the following formula. 

  

<Port (n) Frequency> = <Basic Frequency> × Mn / Dn + On 

 

  

 The basic frequency is a frequency range set by the 
Start and Stop keys in the STIMULUS block. 

Follow the steps below to set the frequency at each port. 

1. Press Channel Next/Channel Prev keys to activate the channel on 
which the frequency-offset is to be set. 

2. Press Sweep Setup key, then click Frequency Offset to display the 
Frequency Offset Menu. 

3. Click Port n (n: any port number) to display Port n Menu. 
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4. Set the frequency for Port-n by using the following softkeys: 
  

Softkey Function 

Multiplier Sets a multiplier for the basic frequency 

Divisor Sets a divisor for the basic frequency 

Offset Sets an offset frequency for the basic frequency 

Start Sets a start frequency of the sweep range for Port-n 

Stop Sets a stop frequency of the sweep range for Port-n 

 You can use both the Multiplier/Divisor/Offset key and 
Start/Stop key to set the frequency for each port. The use of the 
Multiplier/Divisor/Offset key is recommended as a rule. In this 
way, the offset value is automatically retained even if you have 
changed the setting range of the basic frequency, since the 
correlation of the frequencies among ports is defined as a 
formula. Using Start/Stop key will set M and O, which can be 
determined from the specified frequency and the normal 
frequency, while maintaining the preset D. 

 When you measure the 3rd harmonics over 8.5 GHz 
with options 2D5, 4D5, 2K5 and 4K5, it is recommended to 
suppress the carrier signal using filter etc before executing the 
measurement for accurate results. 

 When FOM is used with options 2D5, 4D5, 2K5 and 
4K5, the overload & power trip detection function might have to 
be turned OFF. For more information, see Overload and Power 
Trip Detection. 

Procedures for enabling frequency-offset function 

Follow the steps below to enable the frequency-offset function. 

1. Press Channel Next/Channel Prev keys to activate the channel on 
which the frequency-offset is to be set. 

2. Press Sweep Setup key, then click Frequency Offset to display 
Frequency Offset Menu. 

3. Click Frequency Offset to enable the frequency-offset function (ON). 

4. Once the frequency-offset function is enabled, the frequencies set at 
each port are displayed for each measured trace in the lower part of 
the screen. 
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Keep in mind the following when you turn ON the frequency-offset 
function: 

 If Swept is selected for the Sweep Mode, it will be changed to 
Stepped. 

 The phase information of the measurement value becomes 
meaningless. Therefore, the view of Phase, Group Delay, Smith, Polar, 
Real, Imaginary, Expand Phase or Positive Phase specified with the 
Format key has no actual meaning. In addition, any other function in 
the Conversion menu of the Analysis key that cannot be calculated 
without phase information, including the parameter conversion 
function, will not operate correctly. 

 Fixture Simulator and Time Domain (Transform, Gating) are changed to 
OFF. 

 If the measured frequency exceeds the measurable range, an error 
will occur during the measurement. 

 The number of sweeps during measurement will increase. For 
example, you can use two sweeps to measure the S-parameters of a 
2-port setup in a normal frequency sweep; however, four sweeps are 
needed when the frequency-offset function is turned ON. This holds 
true regardless of whether the ports have the same frequency 
setting. 

2. Setting External Signal Source 

The E5071C allows you to control the external signal source that is 
connected to USB/GPIB interface. 

Preparations for controlling external signal source 

To control the external signal source from the E5071C, you must connect 
its USB port and the external signal source's GPIB connector via the 
USB/GPIB interface. Then on the E5071C you must specify the GPIB 
address and the type of external signal source. 

 The settings of the USB/GPIB interface must be 
made in advance. See Setting the GPIB for more information. 

 To use an external signal source, we recommend 
that you connect the E5071C's internal reference signal output 
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connector and the external signal source's external reference 
signal input connector with BNC cable. This ensures stable 
measurement because the external signal source is phase-
locked on the E5071C's frequency reference signal. 

Procedures for setting external signal source GPIB address 

Follow the steps below to set GPIB address of the external signal source. 

1. Press System key. 

2. Click Misc Setup> GPIB Setup > Signal Generator Address> Address. 

Type the GPIB address of the external signal source you want to use. 
Procedures for selecting external signal source 

The E5071C can use the external signal sources shown below. 

Type Model 

1 User-defined Commands 

2 8643A, 8644B, 8664A, 8665A/B 

3 8648A/B/C/D, ESG Series, PSG Series & MXG Series 

 For type 1, the user-defined commands can be used 
to control the external signal source. Four commands can be 
defined: preset, turning on RF output, setting frequency, and 
setting power. Definitions are required for frequency and power 
level settings. 

 The factory-state definitions are shown below. 

Function Command Description 

Preset "" Not defined 

Turning on RF output "R3"   

Frequency setting "FR %f% HZ" Frequency (Hz) is set to %f% 

Power level setting "AP %p% DM" Power level (dBm) is set to %p% 

Follow the steps below to select an external signal source. 

1. Press System key. 

2. Click Misc Setup > GPIB Setup > Signal Generator Address. 

3. Select the external signal source you want to use. 

4. Switching Time allows you to set the wait time after setting the 
external signal source's frequency and power in ms. 

Procedures for setting external signal source frequency 
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The frequencies set to the external signal source should be a multiplier 
(MLO), divisor (DLO), and offset (OLO) for the basic frequency setting as 
shown in the following formula: 

<LO Frequency> = <Basic Frequency> × MLO / DLO + OLO 

 

 
  

  The basic frequency is a frequency range set by the 
Start and Stop keys in the STIMULUS block. 
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Follow the steps below to set the external signal source frequency. 

1. Press Sweep Setup key, the click Frequency Offset to display the 
Frequency Offset Menu. 

2. Click External Source > Power. 

3. Set a frequency for the external signal source by using the 
softkeys: 

Softkey Function 

Multiplier Sets a multiplier for the basic frequency 

Divisor Sets a divisor for the basic frequency 

Offset Sets an offset frequency for the basic frequency 

Start Sets a start frequency of the sweep range for the external 
signal source 

Stop Sets a stop frequency of the sweep range for the external 
signal source 

 You can use both the Multiplier/Divisor/Offset key and the 
Start/Stop key to set the external signal source frequency. The use of the 
Multiplier/Divisor/Offset key is recommended as a rule. This allows you to 
automatically retain the offset value even if you have changed the setting 
range of the basic frequency, since the external signal source frequency is 
defined as a formula. Using the Start/Stop key will set M and O, which can 
be determined from the specified frequency and the normal frequency, 
while maintaining the preset D. 

Procedures for setting external signal source power level 

Follow the steps below to set the external signal source power level. 

1. Press Sweep Setup key, the click Frequency Offset to display the 
Frequency Offset Menu. 

2. Click External Source > Power. 

3. Set the power level. 

 The mixer's conversion loss and reflection 
coefficients are significantly affected by the power level 
variation of the external signal source (LO signal). The Slope 
provided in the External Source Menu allows you to set a 
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correction in dB/GHz for the power level variation that may 
occur when you change the external signal source frequency. 

  

Procedures for controlling external signal source 

Follow the steps below to control an external signal source. 

1. Press Sweep Setup key, then click Frequency Offset to display the 
Frequency Offset Menu. 

2. Click External Source to display the External Source Menu. 

3. Click LO Frequency to turn it ON. The frequency setting of the 
external signal source (LO) is displayed. 

4. Click Control to turn the external signal source control ON, which 
allows you to send setting values such as frequency to the external 
signal source and start the control. If the external signal source 
control is turned ON, (Ctrl) will be displayed on the screen as shown 
below. 
 

 
 If the external signal source control fails, the GPIB 

setting may be wrong. See Setting the GPIB. 

3. Changing Frequency Data 

The frequency-offset function offers the capability to change the frequency 
data of each trace to any desired frequency. 

Procedures for changing frequency data 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to change the frequency. 

2. Press Sweep Setup key, then click Frequency Offset to display the 
Frequency Offset Menu. 

3. Use the X-Axis key to set the frequency data. 

4. The basic frequency is a frequency range set by the Start and 
Stop keys in the STIMULUS bloc. 

 If you change the frequency data, it will affect all of 
the measurement values, such as the marker's read value, 
conversion parameter, and conversion into time domain. 
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4. Implementing Mixer Calibration 

The E5071C provides a vector-mixer calibration function and a scalar 
calibration function for measuring frequency conversion devices. 

For detailed information on mixer calibration, see Vector-Mixer Calibration 
and Scalar-Mixer Calibration. 

5. Conversion Loss Measurement 

Conversion loss is a typical measurement parameter of a mixer. As shown 
below, conversion loss indicates the level of efficiency in which input 
frequency is converted to another frequency. Furthermore, conversion loss 
can be defined as a proportion of output frequency power to input 
frequency power at a given LO signal level. The following description is 
based on an example of conversion loss measurement by using the vector-
mixer calibration. 

 You must implement vector-mixer calibration in advance. For 
detailed information on vector-mixer calibration, see Vector-Mixer 
Calibration. 
 

 
   
Connection of measured mixer 

Connect the calibration mixer with the IF filter, measured mixer and 
external signal source, as shown below. 
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  If two or more spectrum components are involved at a similar 
level, it is necessary to use a filter in order to prevent unnecessary 
spectrum components from entering the receiver port; in this way, you 
can prevent the total magnitude from reaching a damage level of 6.3 
Vp-p. 

Procedure for setting measurement parameters 

Follow the steps below to set the measurement parameters. In this case, 
we measure each parameter of magnitude, phase, and group delay in 
conversion loss (S12). 

1. Press Channel Next/Channel Prev keys to activate the channel you 
want to measure. 

2. Press Display key to set Num of Traces to 3. 

3. Click Allocate Traces to select the Graph Layout ( ). 

4. Press Meas to set the measurement parameter to S12. 

5. Press Format to set LogMag (magnitude) to Trace 1. 

6. Press Trace Next key to select Trace 2. 
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7. Press Meas to set the measurement parameter to S12. 

8. Press Format to set Phase (phase) to Trace 2. 

9. Press Trace Next key to select Trace 3. 

10. Press Meas key to set the measurement parameter to S12. 

11. Press Format key to set Group Delay (group delay) to Trace 3. 

12. Press Scale key to use Auto Scale All for trace scale optimization. 

Change the frequency data to the desired frequency as required. For 
detailed information on changing the frequency data, see Procedures for 
changing frequency data. 

 For additional information about the absolute measurements, 
see Agilent application note 1463-6 Accurate Mixer Measurements Using 
the Frequency-Offset Mode, 5989-1420EN (Internet Connection is 
required  to open). 
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Measurement Wizard Assistant 

Measurement Wizard Assistant 

 Introduction of the MWA Software 

 MWA Operational Requirements 

 Installation of the MWA Software 

 Creating Spec Sheets using the MWA Front-end Application 

 Executing the Back-end Application in ENA 

 Measurement Example of a Multiport Switch 

 Overview and Restrictions of Group 

Other topics about Measurement with Options 
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Introduction of the MWA Software 

 Overview 

 Front-end Application 

 Back-end Application 

Other topics about Measurement Wizard Assistant 

Overview 

The Measurement Wizard Assistant (MWA) is the software option on the 
ENA that enables easy and fast setup of whole measurement. The software 
consists of two main applications – front-end and back-end application. 
The front-end application running on the Microsoft Excel creates a setup 
file (“spec sheet”) with the .mwa extension which includes all the 
measurement parameters. A spec sheet is then recalled by the back-end 
application of the Microsoft VBA program running on the ENA. All the 
necessary parameters are automatically set up within the ENA by the back-
end application. The back-end application also provides the calibration 
wizard and controls the whole measurement procedure. Operation time of 
network analysis can dramatically reduced by using the MWA software. 

 More information about MWA is available at 
www.agilent.com/find/mwa and in the Application Note "Measurement 
Wizard Assistant software for the ENA". 

 The Measurement Wizard Assistant (MWA) is only available on 
the ENA with the option 790. See ENA options for more details.  
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Front-end Application 

The front-end application is provided as a VBA macro program on Microsoft 
Excel and can be operated in any PCs with the software installed. The 
front-end application generates a spec sheet (.mwa) for the ENA and 
multiport test sets that includes all the necessary parameters of 
measurement. 

The front-end application provides the following functions: 

 Defining measurement configuration 

 Defining the connection between the DUT and measurement 
instruments 

 Setting commands to external peripherals via GPIB interface 

 Setting all measurement parameters in network analysis 

 Creating a setup file (“spec sheet”) for the back-end application 

Back-end Application 

The back-end application is a VBA macro program that runs on the ENA. A 
spec sheet created by the front-end application is recalled and all the 
measurement parameters are automatically set up in the ENA. The back-
end application has the calibration wizard function that provides 
instructions of calibration steps necessary for all measurements. The 
necessary procedure of total measurements is controlled by the back-end 
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application and the detailed results of the measurement are saved within 
the ENA. 

The back-end application provides the following functions: 

 Recalling a spec sheet to setup all the measurement parameters 
automatically 

 Calibration wizard 

 Instruction of connection information 

 Controlling external peripherals via GPIB interface 

 Customizing the measurement procedure 

 Performing limit tests on all measurement paths 

 Reporting detailed results of measurement 
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MWA Operational Requirements 

Requirements for operating the MWA software (Rev 1.1) are as follows: 
A PC for running the front-end application 

 OS: Windows XP 

 Microsoft Excel 2007 
The ENA Network Analyzer (E5070B/E5071B/E5071C) 

 The back-end application of the MWA must be installed. 

 The MWA operates only when the number of channels is three 
or more (four or more for the ENA settings). Set the number of 
channels of the ENA in advance. Refer to Setting Channels and 
Traces for channel setup information. 

Multiport Test Set  

If you wish to make multiport measurements, the following multiport test 
sets are supported by the MWA. 
 E5092A 

 The option 020 (E5092A-020). 

  Configurations of E5092A 13-port, 16-port, 22-port and X-10-
port crossbar are supported by the MWA for the E5092A-020. 

 E5091A 

 The 9-port option (E5091A-009) and the 16-port option 
(E5091A-016). 

 Both 13-port & 16 port configuration is supported by the MWA 
for the E5091A-016. 

 Up to two multiport test set can be used. The E5092A & E5091A 
can be combined with the MWA. 

ECal Module 

When using the ECal module with calibration wizard in the back-end 
application of the MWA, the 4-port ECal module supported by the ENA is 
required. Refer to ECal for supported ECal modules by the ENA. 

  

Other topics about Measurement Wizard Assistant 
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Installation of the MWA Software 

 Overview 

 Installing Front-end Application 

 Installing Back-end Application 

 Evaluation Mode 

Other topics about Measurement Wizard Assistant 

Overview 

The MWA consists of a front-end application, which creates spec sheets on 
the PC, and a back-end application, which makes measurements with the 
E5071C. Each of the installation procedures is described below. 

Installing Front-end Application 

Follow the procedure below to install the front-end application program of 
the MWA on the PC: 

1. Download MWA software evaluation version from 
http://www.agilent.com/find/mwa/. 

2. Extract the MWA software package. 

3. Copy mwa_xxxx.xls (x in  mwa_xxxx.xls means revision number. 
e.g.: mwa_0106.xls) to an appropriate folder on the PC. 

Installing Back-end Application 

When your E5071C is equipped with option 790, the MWA back-end 
application has already been installed on the D:/Agilent/MWA at the factory 
shipment. If you retrofit the option, follow the following procedure: 

1. Download MWA software evaluation version from 
http://www.agilent.com/find/mwa/. 

2. Extract the MWA software package. 

3. Copy mwa_xxxx.vba to the D:/Agilent/MWA folder on E5071C using an 
USB memory, external floppy disk drive, or LAN. 

 The application file name (mwa_xxxx.xls, 
mwa_xxxx.vba) may change when the version is updated. 

 The back-end application of ENA-B and ENA options 
2D5, 4D5, 2K5 and 4K5 model turns OFF the Setting Power 
Level with Auto Power Range function, to protect the hardware 
of ENA. In such cases, if the power values set at front-end 
application are out of range, then the values will be 
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automatically adjusted by the ENA within the power range limit. 
If the adjusted power value exceeds the maximum power input 
of the DUT can cause damage to ENA. 

MWA License Validation and Key Code Entry Procedure 

The MWA validates license and a key code on the initial start-up. Follow 
the procedure below to validate license and enter a key code. 

1. Start the back-end application according to Starting MWA (Back-end 
Application). 

2. When starting the MWA for the first time, the license validation 
dialog appears. Read the contents and press the AGREE button to 
validate license. If you press the DO NOT AGREE button, the back-
end application does not start and the measurement screen of the 
E5071C appears. 

3. The message window named "Do you have a key code?" dialog box 
appears. Press the Yes button to enter a key code. When you press 
the NO button, the back-end application starts in the evaluation 
mode. 

 When incorrect MWA license key code is entered, the 
E5071C firmware initiates a forced restart. 

4. The key code entry dialog appears. Enter the key code specified in 
the certificate that is provided when you order the E5005A, and then 
press OK. If you press the Cancel button or press the OK button 
without entering a key code, the back-end application starts in the 
evaluation mode. 

 Restart E5071C after entering the key code. 

5. The initial screen of the MWA's back-end application appears. 

6. If the hard disk is initialized (when repaired, etc), you need to 
enter the key code again. 

Evaluation Mode 

The evaluation mode is the mode in which the back-end application can be 
used without entering the key code and has the following restrictions. 

 Manual and External Trigger: Up to 100 measurements. 

 Continuous Trigger: Up to 500 measurements. 

When the MWA starts in the evaluation mode, the dialog shown below 
appears before the initial screen of the back-end application is displayed. 
This evaluation mode enables the evaluation of the MWA without 
purchasing MWA. MWA can be retrofitted by the E5005A. 
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Creating Spec Sheet using the MWA Front-end Application 

 Overview 

 Starting MWA (Front-end Application) 

 Selecting Test Set 

 Defining DUT and Connecting to a Test Set 

 Setting Operation Mode of the DUT 

 Setting GPIB Commands in Each Mode 

 Setting Measurement Parameters in Each Mode 

 Generating a Spec Sheet 

 Importing Exporting Parameters 

Other topics about Measurement Wizard Assistant 

Overview 

The front-end application of the MWA creates a setup file named "spec 
sheet" (.mwa) which is used in the back-end application on the ENA. The 
procedure of creating a spec sheet is described below: 

Starting MWA (Front-end Application) 

1. Start Excel and select File > Open. 

2. In the window that opens, select mwa_xxxx.xls and click Open. 

3. When you are asked whether to enable macros, select the option to 
enable them. 

 When opening the front-end application of MWA 1.1 in 
Microsoft Office Excel 2007, the macros of the front-end are 
disabled by default as indicated by “Security Warning” tab.  In order 
to use the front-end application, its macros must be enabled. To 
enable the macros, click “option” button on “Security Warning” 
tab and select either “Enable this content” or “Trust all 
documents from this publisher” on the pop-up “Security Alert – 
Macros & ActiveX” window. 

Selecting Test Set 

The procedure for selecting the configuration of measurement in the 
"Multiport Test Set" sheet is described below: 

1. Select the "Multiport Test Set" tab ([1] in Multiport Test Set Sheet) 

2. Double-click the selection cell for test set 1 ([2] in Multiport Test Set 
Sheet) and select the first multiport test set in the drop-down list. 



Measurement with Option 

553 

The following configurations are available with the MWA: 
  

No. Test Sets Description 

0 None Uses the 4-port ENA only. 

1 E5091A 9-
Port 

Uses the 9-port option of the E5091A (E5091A-009). 

2 E5091A 13-
Port 

Uses the 16-port option of the E5091A (E5091A-016) 
with the 13-port configuration. 

3 E5091A 16-
Port 

Uses the 16-port option of the E5091A (E5091A-016) 
with the 16-port configuration. 

4 E5092A 13-
Port 

Uses the 13-port configuration of the E5092A option 
020 (E5092A-020). 

5 E5092A 16-
Port 

Uses the 16-port configuration of the E5092A option 
020 (E5092A-020). 

6 E5092A 22-
Port 

Uses the 22-port configuration of the E5092A option 
020 (E5092A-020). 

7 E5092A X10-
Port 

Uses the 10-port full crossbar configuration of the 
E5092A option 020 (E5092A-020). 

8 Z5623AK64 This is a test set designed for the PNA-L (N5230A 
option 245). It cannot be used with the ENA. 

9 Z5623AK66 This is a test set designed for the PNA-L (N5230A 
option 245). It cannot be used with the ENA. 

E5092A 13-Port Switching Configuration 
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E5092A 13-Port Configuration Parameter Matrix & Front Panel 
Connection 

 
  

E5092A 16-Port Configuration 

 
  

E5092A 16-Port Configuration Parameter Matrix & Front Panel 
Connection 
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E5092A 22-Port Configuration 

 
  

E5092A 22-Port Configuration Parameter Matrix & Front Panel 
Connection 
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E5092A 10-Port Full Crossbar Configuration 

 
  

E5092A 10-Port Full Crossbar Configuration Parameter Matrix & 
Front Panel Connection 
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3. Type the label names of ports in a cell of the Label column for test 
set 1 ((3) in Multiport Test Set Sheet). The label names typed here 
will be used in the following procedure of the front-end and the back-
end application. 

4. The functionality to Copy & Paste is not available in the front-
end application of the MWA. Make sure to type characters and 
values or select the option from the drop-down list. 

4. Double-click the selection cell for test set 2 ((4) in Multiport Test Set 
Sheet) and select another multiport test set in the drop-down list. 
Following configurations (following table) are available for the second 
test set: 
  

No. Test Sets Description 

0 None Does not use a second test set. 

1 E5091A 9-
Port 

Uses the 9-port option of the E5091A (E5091A-009). 

2 E5091A 13-
Port 

Uses the 16-port option of the E5091A (E5091A-016) 
with the 13-port configuration. 

3 E5091A 16-
Port 

Uses the 16-port option of the E5091A (E5091A-016) 
with the 16-port configuration. 

4 E5092A 13-
Port 

Uses the 13-port configuration of the E5092A 
(E5092A-020). 

5 E5092A 16-
Port 

Uses the 16-port configuration of the E5092A 
(E5092A-020). 
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6 E5092A 22-
Port 

Uses the 22-port configuration of the E5092A 
(E5092A-020). 

7 E5092A X10-
Port 

Uses the 10-port full crossbar configuration of the 
E5092A (E5092A-020). 

 Step 4 through Step 6 is required when two 
multiport test sets are used for measurement. When only one 
test set is used, select None and proceed to Step 7. 

5. Type the label names of the ports in cells in the Label column for 
the test set 2 ((5) in Multiport Test Set Sheet). 

6. Set the number 1 to 4 in the cells in the Link column ((6) in 
Multiport Test Set Sheet), which correspond to the ports 1-4 of the 
second test set. 

7. When the selection of measurement configuration is completed, 
the connectivity matrix in the right ([7] in Multiport Test Set Sheet) 
is automatically updated. Those checked in the table are the paths 
that can be measured. 

Multiport Test Set Sheet 

 
  

Defining DUT and Connecting to a Test Set 

The procedure for defining the characteristics of the DUT and the 
connection with the ports on the ENA or the multiport test set are 
explained below. 
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1. Select the "DUT" tab ([1] in DUT Sheet (1/3)). 

2. Type a label name in a cell in the DUT Label column ((2) in DUT 
Sheet (1/3)) that defines the connection between the DUT and a test 
set. Typing the label name in the cell enables the corresponding port 
of the ENA or the multiport test set. 

3. Double-click the port type selection cell ((3) in DUT Sheet (1/3)) 
below the DUT Label and select a port type from the drop-down list 
or directly input the port type number (1-3). The following types are 
available: 
  

No. Port Types Description 

1 Single Sets the port type to single-ended port. 

2 Common Sets the port type to common-mode port. 

3 Differential Sets the port type to differential-mode port. 

4. If you select Common or Differential as the port type, type into a cell 
in the Sub Label column ((4) in DUT Sheet (1/3)) a label name that 
will be used when the ports are connected to the single-ended ports 
on the ENA or the test set. 

5. Double-click the port selection cell ((5) in DUT Sheet (1/3)) and 
select a port of the test set from the drop-down list. Selection can be 
made from the ports that have been pre-defined in the Multiport Test 
Set sheet. 

DUT Sheet (1/3) 
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6. When you set the port type to Single, enter port impedance in cells 
in the R (for the real part) and X (for the imaginary part) columns 
([1] in DUT Sheet (2/3)) under Z (Single). When you set the port 
type to Common or Differential, enter impedance in cells of the R and 
X columns ((2) in DUT Sheet (2/3)) under Z (Balanced). 

7. Enter into a cell in the Extension column ((3) in DUT Sheet (2/3)) an 
extension time that is applied when the port is extended. If you set 
the port type to something other than Single, enter an extension 
time for each of the two ports. 

 From MWA rev.1.1, embedding and de-embedding 
functions are available in front end application. 
Embedding and Port Matching cannot be used at the same time 
because of the ENA firmware specification. 

Error Message Screen 
 

 
DUT Sheet (2/3) 

 
8. Double-click a cell in the Type column under Port Matching (Single) 

((1) in DUT Sheet (3/3)) to display a dialog box for setting the port 
matching circuit (Dialog box for setting the port matching circuit). 
Select a type, enter values for C, G, L and R and click OK ((1) in 
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Dialog box for setting the port matching circuit). To return to the 
DUT sheet without setting the type and the values, click Cancel ((2) 
in Dialog box for setting the port matching circuit). 

The units of C, G, L and R are F (farad), S (siemens), H (henry) and ohm, 
respectively. An exponent is acceptable as an input format. 

The types of the port matching circuits are as follows: 

Types of Port Matching 
Circuits 

Description 

None No matching circuit is selected. 

SLPC Selects the circuit that consists of series L and 
shunt C. 

PCSL Selects the circuit that consists of shunt C and 
series L. 

PLSC Selects the circuit that consists of shunt L and 
series C. 

SCPL Selects the circuit that consists of series C and 
shunt L. 

PLPC Selects the circuit that consists of shunt L and 
shunt C. 

 Values can be entered directly in cells in the C, G, L 
and R columns ((2) in DUT Sheet (3/3)) instead of using the 
dialog box. 

1. Repeat Step 2 through Step 8 as many times as needed to set all the 
required parameters. 

DUT Sheet (3/3) 
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Dialog box for setting the port matching circuit 

SLPC 

 
PCSL 
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PLPC 

 
PLSC 
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SCPL 

 
   
Setting Operation Mode of the DUT 

The E5092A multiport test set has the capability of DC source that can 
supply the bits of DC control voltage to a DUT. By selecting L (Low) or H 
(High) voltage for each control bit, the operation mode of the DUT can be 
determined. The procedure for setting operation mode in the "Mode" sheet 
is explained below: 

1. Select the "Mode" tab ((1) in Mode Sheet). 

2. Turn ON each cell for the status of operation mode of the DUT ((2) in 
Mode Sheet). 

3. Enter a preferred label name in a cell in the Mode Label column ((3) 
in Mode Sheet). The label name entered here will be used as a tag 
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name of a generated spec sheet. It will also be used by the back-end 
application as a label. 

4. Double-click cells for control voltage (Vc1 through Vc8) under Control 
Line Voltage [TS1] of the first test set ((4) in Mode Sheet) and set L 
(Low) or H (High) voltage for each control line. It is also possible to 
directly input the number 0 or 1 (0 for Low, 1for High). 

5. When you use two test sets, you can set control voltage outputs 
from the second test set. Set cells for Vc1 through Vc8 under Line 
Voltage [TS2] of the second test set ((5) in Mode Sheet) the same 
way as in Step 4. 

6. Repeat Step 2 through Step 5 as many times as needed to set all 
desired modes. 

Mode Sheet 

 
 Control Line Voltage Group (A to D) and DC Source 

Output Voltage options are available only when E5092A test set 
has been selected in the Multiport test set tab. The DC source 
output voltage range varies between 1V-5V with a resolution of 
0.01V depending upon the specification of E5092A. 

 The maximum number of modes is 40. 

DC Source and Control Line Voltage Diagram 
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Setting GPIB Commands in Each Mode 

The procedure explained below is for setting GPIB commands to external 
peripherals in the "GPIB" sheet. A USB/GPIB interface (i.e. Agilent 87357B) 
to connect the ENA and peripherals with the GPIB interface is necessary for 
this function. 

1. Select the "GPIB" tab ((1) in GPIB Sheet). 

2. Under GPIB Command, enter into a cell in the Address column ((3) in 
GPIB Sheet) the GPIB address of the external peripherals to which 
GPIB commands will be sent. 

 To add a new command row to a mode, double-click 
the cell in the Mode column((2) in GPIB Sheet). To delete a 
command row from a mode, place the cursor at the row that 
you want to delete, right-click to display a list, and select Delete 
Command.   
 
To add multiple rows at one time, place the cursor at the row of 
the command to which you want to add the new rows, right-
click to display the Command Count dialog and set the number 
of rows as needed in the particular mode. 

 GPIB commands can be sent to the ENA itself by 
entering -1 into a cell in the Address column. 
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3. Enter into a cell in the Command column ((4) in GPIB Sheet) a 
GPIB command to be sent. 

4. Enter the wait time into a cell in the Wait [ms] column ((5) in 
GPIB Sheet) under GPIB Command. This wait time (in msec) should 
be set to insert the data transaction time between the ENA and a 
peripheral in the testing system, when a query command is sent to 
the peripheral during the measurement. 

5. Double-click a cell in the Type column ((6) GPIB Sheet) to 
display a drop-down list and select the desired command type. The 
following options are available: 
  

No. Command 
Type 

Description 

1 Limit Set this where a query command is sent via GPIB. The 
returned value is used in the limit test by the back-end 
application. 

2 Pre Set this where a GPIB command is sent before 
measurement starts in the back-end application. 

3 Post Set this where a GPIB command is sent after 
measurement ends in the back-end application. 

 The command type can be set only for GPIB 
commands that have been set in Setting Operation Mode of the 
DUT. GPIB command types cannot be set in INIT mode. 

 In INIT mode, a command is executed only once 
when spec sheets are read by the back-end application. Since 
this execution of the commands  takes place before 
measurement, set such commands to initialize the state of an 
external peripheral. 

6. When Limit is selected for the command type, enter the lower limit 
value, the upper limit value and a rank number in cells in the Min, 
Max and Rank columns ((7) in GPIB Sheet), respectively. These 
figures are used in the limit test by the back-end application on a 
returned value of a query command to the peripherals.  For details 
on the rank, refer to Step 11 in Setting Measurement Parameters in 
Each Mode. 

 The lower limit values, the upper limit values, and 
the ranks can be set in cells under GPIB Limit only if the 
selected GPIB command type is Limit. This does not apply to Pre 
or Post GPIB commands. This setting cannot be performed for 
GPIB commands in the INIT mode either. 
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7. Repeat Step 2 through 6 as many times as needed to set GPIB 
commands in each mode. 

GPIB Sheet 

 
  

Setting Measurement Parameters in Each Mode 

The procedure described below is for setting all the measurement 
parameters of modes that are pre-defined in Setting Opeartion Mode of the 
DUT. 

1. Select the "Spec Sheet" tab ((1) in Spec Sheet (1/2)). 

2. Double-click the From column under Path ((3) in Spec Sheet (1/2)) 
and select a DUT port that is connected to the source port of the ENA 
from the drop-down list. The selection can be made from the ports 
that have been defined in Defining the DUT and Connecting to a Test 
Set. 

 To add a new row to a measurement path, double-
click the cell in the Mode column ((2) in Spec Sheet (1/2)). To 
delete a row of a measurement path, place the cursor at the 
row you want to delete, right-click to display the list, and select 
Delete Record. 
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To add multiple new measurement paths, place the cursor at 
the mode, right-click and select Path Count...In the displayed 
Path Count dialog, set the number of paths as needed. 

Path Count Dialog 
 

 
3. As in Step 2, double-click a cell in the To column under Path ((3) of 
Spec Sheet (1/2)) to display a drop-down list and select a DUT port that is 
connected to the receiver port of the ENA. 

4. Double-click a cell in the Type column ((4) in Spec Sheet (1/2)) to 
display a drop-down list and select measurement type for each path. The 
following types can be selected: 
  

No. Measurement Description Parameter Data 
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Type Format 

1 IL Performs the 
Insertion Loss 
measurement 

Transmission LogMag 

2 Ripple Performs the 
Ripple 
 measurement 

Transmission LogMag 

3 VSWR Performs the 
Voltage 
Standing Wave 
Ratio 
 measurement 

Reflection VSWR 

4 RL Performs the 
Return Loss 
 measurement 

Reflection LogMag 

5 ATT Performs the 
Attenuation 
measurement 

Transmission LogMag 

6 Isolation Performs the 
Isolation 
measurement 

Transmission LogMag 

7 BalAmp Performs the 
Imbalance 
measurement 
with balanced 
port. (in 
magnitude) 

Imbalance LogMag 

8 BalPhase Performs the 
Imbalance 
measurement 
with balanced 
port. (in phase) 

Imbalance Phase 

9 Phase Performs the 
Phase 
measurement. 

Reflection / 
Transmission 

Phase 

  

10 Group Delay Performs the 
Group Delay 
measurement. 

Reflection / 
Transmission 

Group 
Delay 

11 Lin Mag Performs the 
measurement in 
linear 

Reflection / 
Transmission 

LinMag 
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magnitude. 

12 Real Performs the 
measurement in 
real. 

Reflection / 
Transmission 

Real 

13 Imag Performs the 
measurement in 
imaginary. 

 Reflection / 
Transmission 

Imaginary 

 The limit test is performed by the back-end 
application with the limit values in the spec column. (Described 
in Step 8). The sign change is required for the limit test value in 
case of the IL, RL, ATT or Isolation measurement type. For 
example, the maximum -5dB of insertion loss is the allowable 
specification of the DUT, input 5 (dB) in the maximum (Max) 
value in the spec column. If you need the isolation at least 
below -80dB in the measured path, you should input 80 (dB) in 
the minimum (Min) value in the spec column for the limit test. 
  

Spec Sheet (1/2) 

 
5. Enter the start frequency, the stop frequency and the number of 

measurement points in the cells in Start, Stop and Pts columns ((5) 



E5071C 

572 

in Spec Sheet (1/2)) under Frequency [MHz]. These figures will be 
the sweep settings that are used to perform measurement by the 
back-end application of the ENA. 

6. Frequency offset mode is available with the MWA by entering the 
start and stop frequency at the receiver port on the ENA in cells in 
the Start and Stop columns ((6) in Spec Sheet (1/2)) under Rcv Freq 
[MHz]. 

7. Set the output level, the IF bandwidth and the sweep mode of a port 
on the output side using cells in the Power, IFBW [Hz] and Sweep 
Mode columns under Sweep Setting ((7) in Spec Sheet (1/2)). 
Double-click the sweep mode cell to display a drop-down list and 
select a sweep mode of the ENA. The following options are available: 
  

No. Sweep 
Modes 

Description 

1 Std. 
Stepped 

Sets the sweep mode to the stepped mode. 

2 Std. Swept Sets the sweep mode to the swept mode. 

3 Fast 
Stepped 

Sets the sweep mode to the fast stepped mode (This 
mode is only for the E5070B/E5071B.) 

4 Fast Swept Sets the sweep mode to the fast swept mode (This 
mode is only for the E5070B/E5071B.) 

8. Enter the limit values of a measurement parameter in cells in the Min 
and Max columns ((1) in Spec Sheet (2/2)) under Spec column. The 
values entered here will be used for the limit test in the back-end 
application to evaluate measured parameters. If no values are 
entered in the cells, -999 is assumed for Min (lower limit) and 999 
for Max (upper limit). 

9. The measured data can be converted in the back-end application. In 
such cases enter correction values in cells in the Start and Stop 
columns under Corr. Multiplier ((2) in Spec Sheet (2/2)) and cells in 
the Start and Stop columns under Corr. Offset((3) in Spec Sheet 
(2/2)). The correction is done on the measured data at the start 
frequency and the stop frequency with the entered multiplier and 
offset values. The measured data on each point in between the two 
frequencies is linearly interpolated. 

10. A cell in the Diff (difference) column under Corr. ((4) in Spec 
Sheet (2/2)) can be checked by double clicking. When a path has a 
check mark in this cell, the difference between the corrected value in 
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the first path and the other checked paths of the mode can be tested 
between in the back-end application. 
 
This feature can be used for harmonic measurement (in dBc) by 
entering the parameters at the carrier frequency in the first path and 
the parameters at the harmonic frequencies in the next paths. 

 The first path in each mode cannot be checked 
because it is automatically assigned as the measurement 
reference for calculating differences from the other paths. 

Spec Sheet (2/2) 

 
11. Enter a rank number into a cell in the Rank column ((5) in Spec 

Sheet (2/2)) Rank can be used to prioritize the test result of 
measurement paths of the DUT. The rank number can be ranged 
from 0 to 255 and the lowest number of the rank is outputted to the 
handler I/O on the ENA by the back-end application after the 
completion of the limit test. This will indicate the most critical failure 
of the measurement path of the DUT in the limit test. When the test 
result gives the pass for all measurement paths, the returned rank 
number is 0. 

12. A cell in the Selected column ((6) in Spec Sheet (2/2)) can be 
checked by double-clicking. The measurement of the path with the 
checked mark in the cell is performed in the back-end application. 
You can select in the back-end application whether to apply the 
selective measurement or not. 

13. Enter the tag name of a measurement path in cells into the Tag 
Name columns ((7) and (8) in Spec Sheet (2/2)). The first part of 
the tag name ((7) in Spec Sheet (2/2)) is assigned automatically 
with the corresponding mode and path number, and cannot be 
modified. The second part of the name ((8) in Spec Sheet (2/2)) can 
be changed as needed. 
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14. Repeat Step 2 through Step 13 as many times as needed to set 
up measurement path details in each mode. 

  

Generating a Spec Sheet 

The procedure explained below is for verifying the contents of the settings 
and generating a spec sheet for the back-end application in the “Output” 
sheet. 

1. Select the "Output" tab ((1) in Output Sheet).The channel and trace 
allocation of each measurement path on the ENA is automatically 
displayed in the sheet 

 An error message dialog is displayed if there is any 
invalid input in the previous sheets of the front-end application. 
Press Yes in the dialog to return to the portion that caused the 
error. 
 

 
2. Enter the maximum channel number of the ENA in the Max Channel 

cell ((4) in Output Sheet), the maximum number of traces per 
channel in the Max Trace cell ((5) in Output Sheet), and the 
maximum number of measurement points in the Max Point cell ((6) 
in Output Sheet) at the top of the "Output" sheet. 
 
Based on the values entered here, all the measurement paths in all 
the modes are automatically allocated to appropriate channels. 

3. Information on all the measurement paths in all the modes and 
corresponding channels, traces, and segments is shown in the Output 
sheet ((2) in Output Sheet). Check the information and correct the 
corresponding sheet if there are any errors. 

4. Detailed information on each channel including the test set ID, 
connected port number of the test set, measurement parameters on each 
trace is displayed ((3) in Output Sheet). Check the information and 
correct the corresponding sheet if there are any errors. 

5. If all information shown in the Output sheet is correct, press Save Spec 
Sheet ((7) in Output Sheet) at the top of the sheet to display the Save 
dialog box. Select a folder and enter a preferred file name and press Save 
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to generate and save a spec sheet, which will be used by the back-end 
application. 

Output Sheet 

 
 The maximum channel of the ENA is 160 from 

rev.A.09.10. 
  

Importing/Exporting Parameters 

The procedure explained below is for importing/exporting the parameters 
in the csv format with the "System" sheet. 

1. Select the "System" tab ((1) in System Sheet). 
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2. Press Export ((3) in System Sheet) to display the Export Data dialog 
box. 

3. Enter a file name and press OK. All the entered parameters in the 
front-end application are exported to a file in csv format. 

4. To import the parameters from a csv files, press Import ((2) in 
System Sheet) to display the Import Data dialog. 

5. Select a csv file to read and press OK. The parameters in the csv file 
can be imported in the front-end application. 

 System Sheet 

 
 Because the exported file (.csv) is not a spec 

sheet,(.mwa) generated in the “Output” sheet, it cannot be 
recalled in the back-end application. 

 

Executing the Back-end Application in E5071C 

 Overview 

 Starting MWA Back-end Application 

 Description of Windows 

 Selecting and Clearing Spec Sheets 

 Checking Connections 

 Calibration Procedure 

 Saving State File 

 Measurement Procedure 

 Created Result Files 

 Controlling the Back-End Application From An External PC 
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 Operation of Handler I/O by the MWA 

 Error messages in the Back-End Application 

Other topics about Measurement Wizard Assistant 

Overview 

The back-end application of the MWA is a VBA program running on the 
E5071C. The back-end application reads a spec sheet (.mwa) created by 
the MWA front-end application, and automatically sets up all the 
measurement parameters on the E5071C. Based on the information 
included in the spec sheet,the back-end application sets up the E5071C 
multiport test set, or the external peripherals,and executes measurement 
procedure the detailed analysis report of the results. 

Starting MWA (Back-end Application) 

A method for starting the back-end application of the MWA on the E5071C 
is explained below. 

1. Press Macro Setup on the front panel. 

2. Click the softkey Load Project... to display the open dialog. 

3. Select the back-end application (mwa_xxxx.vba) and click Open. 

4. Click the softkeys Select Macro > Module1 Main. 

5. The main window of the back-end application is displayed. 

6. If mwa_xxxx.vba is located in the D:/Agilent/MWA folder of the 
E5071C, the back-end application can be launched by the 
softkeys Load & Run > mwa_xxxx. 

  

Description of Windows 

The back-end application of the MWA has the following windows: 

1. Main Window 

2. Spec Sheet Setting Window 

3. Connection Information Window 

4. Calibration Wizard Window 

5. All Spec Sheets Measurement Window 

6. Measurement by Spec Sheet Window 

7. Results Verification by Mode Window 
1. Main Window 

This is the first window displayed after startup. 

In this window, the following buttons can be selected for enabling 
functionality available in the back-end application 
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Main Window 

 
 Add Spec Sheet Group button (Main Window ) 

Displays Spec Sheet Setting Window. 

 Clear All Spec Groups button (Main Window ) 

Clears group files that have been already read in the Spec Sheet Setting 
Window. 

 Cal Wizard button (Main Window ) 

Displays Calibration Wizard Window (1/2)for automatic calibration 
procedure. 

 Save State button (Main Window ) 

Saves a status file on the E5071C. As a status file is automatically saved in 
the E5071C when saving a group file or the necessary calibration is 
completed in the Calibration Wizard Window, it is not necessary to press 
this button if the setting on the E5071C is not changed. 

 Connection Information button (Main Window ) 

Displays Connection Information Window for verifying the connectivity 
of the network analyzer, the multiport test set, and the DUT. 

 Measurement button (Main Window ) 

Displays All Spec Sheet Measurement Window for launching measurement 
procedure. 

 Minimize button (Main Window ) 
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Minimizes the window of the back-end application. This function provides 
easy access to the display of the E5071C for changing parameters after 
recalling a spec sheet. 

 Spec Sheet List (Main Window ) 

The recalled group files with the list of spec sheets are displayed in the 
Main Window after the setup in the Spec Sheet Setting Window (link 
inserted). The name of spec sheets, the number of group files, and the 
allocated channel number of the E5071C are included. The option button 
for each group file can be enabled for selecting the active group file used in 
the measurement. 

If multiple spec sheets are bundled in a group file, the option button of the 
first sheet can be enabled for the group file (It is not necessary to select 
the other spec sheets). 

The group with the circle mark (● ) on the option button is the current 
active group. The calibration performed in the Calibration Wizard Window 
and the measurement is effective for this active group. The state file is 
saved by the Save State button (Main Window ) for the active group file as 
well. 

2. Spec Sheet Setting Window 

In this window, spec including all the parameters for the setup on the 
E5071C are recalled. The multiple spec sheets are bundled into one group 
and handled as a group file (.ssg) in the following procedure of the back-
end application. Up to 10 different spec sheets can be added in one group 
file. 

 Spec Sheet Setting Window 
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 Read Group File... button 

Recalls a saved group file (.ssg). 

 An error occurs when power value is set to different 
value by E5071C firmware. 
In front-end application, the resolution of power value which 
can be set is 0.05dBm. 

 Create New Group... button (Spec Sheet Setting Window (x)) 

Creates a new group file (.ssg). 

 Browse... button (Spec Sheet Setting Window (x)) 

Displays the file selection dialog for status files of the group. 

 Add Spec Sheets... button (Spec Sheet Setting Window (x)) 

Adds a spec sheet (.mwa) under the group file. The default name of the 
group file is named after the recalled spec sheet. 

 Clear All Spec Sheets button (Spec Sheet Setting Window (x)) 

Clears all the spec sheets that have been already recalled in the 
window. 

 OK button (Spec Sheet Setting Window (x)) 

Reflects all the settings on the E5071C according to the recalled spec 
sheets and returns to the Main Window. The state file for the group is 
saved automatically. 

 Cancel button (Spec Sheet Setting Window (x)) 

Discards the settings and returns to Main Window. 
3. Connection Information Window 

This window is displayed when Connection Information in the Main Window 
is selected. 

Using the label names defined in the front-end application, this window 
shows information on the connection between the E5071C, the multiport 
test set(s),and the DUT. 

Connection Information Window 
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 Close button 

Closes the window and returns to the Main Window. 
  

4. Calibration Wizard Window 

This window is displayed when Cal Wizard in the Main Window is selected. 

The wizard provides the necessary steps of the calibration procedure with 
the E5071C and the multiport test set in accordance with the contents of 
recalled spec sheets. 

Calibration Wizard Window (1/2) 
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 List of Calibration Types 

Displays the calibration types that can be performed with the calibration 
wizard. 
  

These include Mechanical Cal Kit (calibration with the mechanical 
calibration kit), 4-Port ECal (calibration with the 4-port ECal module), 
Source Power Cal and Receiver Power Cal (Receiver calibration). 

 Source Power Cal is applied only to the measurement 
paths whose Receiver frequencies in the spec sheet of front-end 
application has been filled. 

 List of Calibration Kits 

Displays the list of mechanical calibration kits available on the E5071C 
for the calibration. This can be selected when Mechanical Cal Kit is 
selected as the calibration type. 

 List of ECals 

Displays the list of characteristics registered in the ECal modules. User-
defined characteristics of the ECal module (User 1 to 5) can be selected 
for calibration with different types of connectors. 
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 Averaging Count Entry 

Sets the averaging number for measurements during calibration. This 
averaging number is used only during calibration and returns to the 
original number registered in the E5071C when calibration is 
completed. 

Calibration Wizard Window (2/2): mechanical calibration kit 
selected 

 
Calibration Wizard Window (2/2): 4-port ECal selected 
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 During execution of the calibration wizard, the port 
name in Port or the calibration standard in CalKit in Calibration 
Wizard Window may be grayed-out. This means "the connection 
between the port and the calibration standard is the same as 
step in calibration procedure"; therefore it is not necessary to 
disconnect the standards for the calibration measurement. 

 Measure button 

Performs calibration measurement with the displayed connection. 

 <Back button 

Goes back to the previous step in the Calibration Wizard. 

 Next > button 

Goes to the next step in the Calibration Wizard after the calibration 
measurement is completed. 

 Cancel button 

Aborts the Calibration Wizard and returns to the Main Window. 

 Done button (Cancel button changes) 

Performs the correction of error coefficients on every necessary port 
then returns to Main Window. 

 Calibration data are automatically saved in the status 
file (.sta) of the group. 

5. Measurement Window 

All Spec Sheets Measurement Window 

This window is displayed after the setup in the Lot Input Window when the 
Measurement button in the Main window is selected. 

Spec sheets and summaries of their measurement results are listed in this 
window. To check the results by spec sheet, select each spec sheet in this 
window and press Manual Trigger. 

All Spec Sheet Measurement Window 
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 Spec Sheet button (All Spec Sheet Measurement Window (x)) 

Displays Measurement by Spec Sheet Window. 

The spec sheet button with the black triangle icon to its left indicates 
the next sheet to be measured. 

 Measurement ON/OFF check box (All Spec Sheet Measurement 
Window (x)) 

Only the spec sheet with a checked mark is measured. 

 Half button 

Rescale the Measurement Window of the back-end application with the 
half size of the screen. The window is located at the bottom half of the 
screen and the measurement results of the E5071C is displayed in the 
top half. See the Measurement Window in half mode. 

 Minimize button 

Minimizes the Measurement Window. See the minimized window. 

 Manual Trigger button 

Makes an immediate measurements with manual trigger on the checked 
spec sheets in the window. (The black triangle icon is displayed to the 
left of the Spec Sheet button.) 
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 Skip button 

Skip the measurement of the spec sheet with a black triangle icon on 
the left. 

 New Measurement button 

Ends measurement in the current window, saves the results, and 
displays All Spec Sheet Measurement Window with a new lot name. 

 End Measurement button 

Ends measurement in the current window and returns to the Main 
Window. The measurement results are saved in the designated 
directory of the E5071C. 

Measurement by Spec Sheet Window 

This window is displayed by selecting one of the buttons for the spec 
sheets that are listed in the All Spec Sheets Measurement Window. 

This window shows a list of the measurement modes in the selected spec 
sheet. To make measurements while checking measurement results in 
different measurement modes, press Manual Trigger in this window. 

 Measurement by Spec Sheet Window 

 
 Manual Trigger button (Measurement by Spec Sheet Window (1)) 

Makes an immediate measurement with manual trigger on the checked 
spec sheets in the All Spec Sheets Measurement window.(The same 
function on the Manual Trigger button in the All Spec Sheets 
Measurement Window). 
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 Close button (Measurement by Spec Sheet Window (1)) 

Returns to the All Spec Sheet Measurement window. 

Results Verification by Mode Window 

This window is displayed by selecting one of the buttons for the 
measurement modes listed in the Measurement by Spec Sheet Window. 

This window shows a list of measurement results for the measurement 
paths specified in the selected measurement mode. 

Results Verification by Mode Window 

 

 Measurement results display area 

Path: The label name of a measurement path that is 
defined in the "Spec Sheet" in the front-end application. 

  

Spec Min/Max: The maximum and minimum limit values of 
the DUT specification for the measurement paths. These 
values are entered in the "Spec Sheet" in the front-end 
application. 

  

Worst Value: The limit test by the back-end application is 
performed for each measurement point and the worst 
value of the DUT is displayed in the measurement result. 
The worst value is defined as the farthest value from the 
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average of the maximum and minimum limit values, which 
corresponds to the typical measured data of the DUT. 

  

Pass/Fail: Indicates the result of the limit test for all data 
in the measured path. 

  

Rank: The rank value of each measurement path (specified in 
the Spec Sheet sheet in the front-end application). The result 
of the limit test can be prioritized and sorted in all the 
measurement paths with the fail. The back-end application 
outputs the minimum rank value among the failed 
measurement paths. For example, by assigning the smallest 
rank value for a specific measurement path, you can identify 
the worst performance of the DUT with the output of the rank 
value after the measurement. 
 
If the result of the limit test gives pass for all the 
measurement paths, the output rank value is "0". 

The definition of the pass/fail result of the measurement 
can be ranged by the Max Fail Rank specified in the Lot 
Input Window of the back-end application. When the rank 
value is greater than the max fail rank value, the failed 
result of the limit test is treated as pass, and the 
corresponding rank values for measurement paths are 
outputted in the result. The following table shows an 
example of the output rank values, when (the Max Fail 
Rank is set to 200). 

Rank value for path Pass/Fail Rank to be output 

1 - 200 Fail 1 - 200 

201 - 255 Pass 201 - 255 

  

For the measurement value, Worst Value, and Pass/Fail judgment, refer 
to step10 of the Setting Up Measurement Parameters in Each Mode. 

 Close button 

Returns to Measurement by Spec Sheet Window. 
  

6. Other Windows 

Measurement Window in Half mode: This window is shown when half in the 
All Spec Sheets Measurement Window is pressed. 



Measurement with Option 

589 

You can use this window when you want to use the MWA while watching 
the measurement result displayed in the screen of the E5071C. In this 
window, only a failed measurement path is displayed and you can check 
the corresponding channel and trace for further investigation of the result. 

If the measurement paths cannot be displayed in one screen, the <<Prev 
button and the Next>> button become effective. 

If you check the Disp enable check box, Display Update function of E5071C 
is activated for drawing the image on the screen. It is recommended to 
disable this function and save time for updating the display when the fast 
testing speed is really required. 

Measurement Window in Half Mode 

 
Lot Input Window 

The lot input window is used for the setup of the measurement.  For more 
information, refer to the Measurement Procedure (All Spec Sheets 
Measurement Window). 

Lot Input Window 
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Selecting and Clearing Spec Sheets 

The procedure described below is for selecting or clearing spec sheets in 
the Main Window or in the Spec Sheet Setting Window. 

Selecting Spec sheets 

1. Press Add Spec Sheet Group in the Main Window to display the Spec 
Sheet Setting Window. 

2. To create a new group, press Create New Group... in the window, type 
the name of the new group in the file dialog, and press Save. 
 
To recall an existing group, press Read Group File... in the window, 
select the group file in the file dialog and press Open. 
 
The full path name of the group file entered or selected is displayed 
in the window 

3. To specify the state file to be associated with the group, press 
Browse... in the State File frame, select the state file to recall and 
press Open. 
 
The full path name of the selected state file is displayed in the 
window. 

4. Press Add Spec Sheets... in the window. Select the spec sheet to use 
in measurements and press Open. 

The name of the selected spec sheet and allocated channel numbers in 
E5071C will be displayed in the window. 

 To select multiple spec sheets, repeat Step 4 as 
many times as needed to read all necessary spec sheets. 
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 When you select a spec sheet without selecting a 
group file or a status file, the displayed names of these files are 
the same as that of the spec sheet. 

 If an error message appears, refer to Error messages 
in the Back-End Application. 

5. After selecting all the necessary spec sheets, press OK to return to 
the Main Window. The name of the spec sheet and the allocated 
channel information will be displayed in the Main Window. 
 
All the functions in the Main Window become available after the spec 
sheet is imported in the back-end application. 

6. When no spec sheet is imported or all the spec sheets are 
cleared by Clear All Groups, the buttons in the Main Window are 
Disabled and the related their functions become unavailable. 

Clearing group files 

1. Select Clear All Groups in the Main Window after setting up the group 
file in the Spec Sheet Setting Window. 

2. All the group files are cleared and all the buttons in the Main Window 
become Disabled and the related functions become unavailable. 

3. It is not available to clear each group file individually. 
  

Checking Connections 

The procedure described below is for checking the connection between the 
measurement instruments and the DUT in the Connection Information 
Window. 

1. Select Connection Information in the Main Window after recalling a 
spec sheet. 

2. The Connection Information Window is displayed. Based on the 
information on the screen, connect the cables between the E5071C, 
the multiport test set(s) and the DUT. 

3. After checking that the connection is correct, press Close to close the 
window and return to the Main Window. 

 The connection should be confirmed before the 
calibration procedure in the Calibration Wizard Window. It is 
also recommended to check the connection again before 
starting the measurement in the Measurement Window. 

  

Calibration Procedure 

The procedure described below is for performing the calibration procedure 
by the Calibration Wizard Window of the back-end application. 
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1. Select a group file to calibrate with the radio button in the Main 
Window. 

2. Select Cal Wizard in the Main Window. 

3. The calibration wizard starts up and the Calibration Wizard window 
(1/2) is displayed. From the list of types of calibration shown in the 
window, select the type of calibration to perform. The following 
options are available: 
  

Type of 
Calibration 

Description 

Mechanical Cal 
Kit 

Uses a calibration kit to perform calibration. For information 
on the selecting a calibration kit, refer to Step 4. 

4 Port ECal Uses 4-port ECal to perform calibration. 

Receiver Cal Performs Receiver calibration while making FOM 
measurements. 

4. If Mechanical Cal Kit is selected in Step 3, the list of calibration kits 
available for selection is displayed in the window. Select the 
appropriate calibration kit to use. 

If 4-port Ecal has been selected in Step 3, the list of user-defined 
characteristics of the ECal module is displayed in the window. Select the 
appropriate characteristics of the ECal module to use. Refer to User-
characterized ECal for more detail. 

 The information on displayed calibration kits has 
been imported from the E5071C firmware. When the 
parameters of the calibration kit are changed in the E5071C, 
corresponding information will be reflected in the back-end 
application as well. 

5. Enter the number of averaging during the calibration 
measurement into the Averaging Count input box. All the parameters 
on the calibration kit are selected, press Next for the next step in the 
calibration procedure. 

6. The Calibration Wizard Window (2/2) will be displayed. Both the 
ports of the E5071C or the multiport test set and the calibration 
standards  used for the calibration are displayed. Connect the ports 
with the standard and press Measure. After the calibration 
measurement is completed, press Next > for the next step. 

7. Repeat Step 6 as many times as needed for all the calibration 
steps necessary for the selected spec sheets. After all the calibration 
measurement is completed, press Done and return to the Main 
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Window. The Calibration data will be saved in the state file of the 
selected group file automatically. 

 When performing calibration with ECal,the MWA back-end 
application shows "Execution error" if active channel is selected for 
trigger scope on the E5071C firmware. Hence, select All Channels for 
the trigger scope. 

Saving State File 

The procedure for saving state files  in the Main Window is described 
below. 

The State file for a group is automatically saved when you create a group 
file in the Spec Sheet Setting Window or you perform calibration in the 
Calibration Wizard Window. If parameters on the E5071C are changed 
without using the functions of the back-end application, a state file should 
be saved manually in the Main Window. 

1. Press Save State in the Main Window. 

2. The State Files (.sta) of the current active groups are updated. 
  

Measurement Procedure (All Spec Sheets Measurement Window) 

The procedure described below is for making measurements by spec sheet 
in the All Spec Sheets Measurement Window. 

1. After the setup of spec sheets in the Spec Sheet Setting Window, 
 press Measurement in the Main Window. The lot Input Window is 
displayed. 

2. Enter the lot name of the DUT. Check optional functions in the 
measurement as necessary and press OK. 

 Output Start/Stop Values 

This option allows you to write measured values at the start and stop 
frequencies to a result file of the measurement. The back-end application 
automatically generates the result file for each spec sheet after the 
measurement. Refer to Measurement result by spec sheet. 

 Correction (Limit Test) 

This option allows you to reflect the correction on measured values 
specified in the “Spec Sheet” front-end application, refer to Step 9 in the 
Setting Measurement Parameters in Each Mode. 

 Enable Manual Measurement 

This option enables the Manual Trigger button in the All Spec Sheets 
Measurement Window and the Measurement by Spec Sheet Window. When 
this option is not checked, manual measurements using the Manual Trigger 
button cannot be made. 
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 Overwrite Output File 

This option allows you to overwrite or add the measurement result when a 
result output file already exists. When this option is checked, the existing 
file is overwritten. 

 Max fail rank (1-255) 

This option sets the maximum rank value for the fail result in the limit test. 
For example, when "max fail rank" is set to 10, the result for measurement 
paths with ranks 1 through 10 treated as fail and 11 through 255 treated 
as pass. For more information, refer to rank in Measurement results 
display area. 

When you press the OK button, the All Spec Sheet Setting Window is 
displayed. 

3. Press Skip to place the black triangle icon to the left of the desired 
spec sheet with which measurements are made. 

4. With the black triangle icon placed to the left of the spec sheet for 
use during measurement, press Manual Trigger to perform 
measurement. 

To do the measurement for the selected measurement paths that have 
been checked in the "Spec Sheet” of the front-end application, check 
Selected Measurement and press Manual Trigger. 

To make consecutive measurements using the displayed spec sheets, 
check the Continuous check box. 

5. When measurements for the spec sheets are completed, the 
measurement result (Pass or Fail) is displayed to the right of each 
spec sheet. 

6. To check measurement result for each spec sheet, press the 
button of the desired spec sheet to display the Measurement by 
Spec Sheet Window. For information on the Measurement by 
Spec Sheet Window, refer to Measurement Procedure 
(Measurement by Spec Sheet Window). 

Measurement Procedure (Measurement by Spec Sheet Window) 

The procedure described below is for selecting one of the spec sheets in 
the measurement window, and making detailed measurement in the 
Measurement by Spec Sheet Window for each measurement mode included 
in the spec sheet. 

1. In the All Spec Sheets Measurement Window, press the button of the 
desired spec sheet to display the Measurement by Spec Sheets 
Window for the spec sheet. 
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2. Press Manual Trigger to launch the measurement for each mode in 
the selected spec sheet. 

To do the measurement for the selected measurement paths that have 
been checked in the Spec Sheet” sheet of the front-end application, 
check the box for Selected Measurement and press Manual Trigger. 

To make consecutive measurements with continuous sweep for all the 
measurement modes, check the Continuous check box. 

3. When measurements are completed, the letter "P" (for Pass) or "F" 
(for Fail), is shown to the right of the measurement mode. Press 
Close, to return to the All Spec Sheets Measurement Window. 

4. To check detailed measurement results for each measurement 
mode, press the button for the desired measurement mode to 
display the Results Verification by Mode Window. For 
information on the Results Verification by Mode Window, refer to 
Measurement Procedure (Results Verification by Mode Window). 

Measurement Procedure (Results Verification by Mode Window) 

The procedure described below is for selecting one of the measurement 
modes and checking results by measurement path in the Results 
Verification by Mode Window. 

1. To display the Results Verification by Measurement Mode Window, 
press the button of the desired measurement mode in the 
Measurement by Spec Sheet Window. 

2. Measurement results for each measurement path are listed in the 
Results Verification by Measurement Mode Window. For more details 
in the listed parameters, refer to measurement results display area 
in the Results Verification by Mode Window. 

Created Results File 

This section describes measurement result files that are created at the end 
of a measurement. 

1. Measurement result summary by lot 

This file is created at the end of a measurement or when the name of a lot 
is changed by selecting New Measurement in the All Spec Sheets 
Measurement Window. It is created in csv format and saved automatically 
in the E5071C. 

The content of the created file is shown in Measurement result summary 
by lot. 

Measurement result summary by lot 
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The first line is the header of a file and the second line or below contains 
the measurement result for each spec sheet. The following parameters are 
included in the result: 

 Spec Sheet x: The name of a spec sheet used in the measurement. 

 Total Number: The total number of the measurement for the lot of 
the DUT. 

 Pass Number: The total number of the pass result for the lot of the 
DUT. 

 Mode x: The label name of the mode in a spec sheet that gives the 
fail result in the measurement. 

 Mode x Fail Number: The total number of the fail result for the mode 
in a spec sheet. 

2. Measurement result by spec sheet 

The file of measurement result is created separately for each spec sheet. 
Each file is created in csv format ("Lot name"-"spec sheet name".csv) and 
saved automatically in the same folder as each spec sheet (.mwa) of 
E5071C. The content of the created file is changed depending on the 
selection of the “output start/stop value” check box in the Lot Input 
Window. 

The content of the created file is shown in Measurement result by spec 
sheet. 

Files of measurement results by spec sheet (start/stop value: ON) 

"Index","Rank","Mode1-Path1",,,"Mode1-Path2",,,"[GPIB**Address] GPIB Command, ... ,"ModeX-
PathY",, 

,,"Start","Stop","Worst", ... ,"Meas", ... ,"Start","Stop","Worst", ... 

1,Output Rank,Start_Value,Stop_Value,Worst_Value, ... ,GPIB_Response Value, ... 
,Start_Value,Stop_Value,Worst_value, ... 

2,Output Rank,Start_Value,Stop_Value,Worst_Value, ... ,GPIB_Response Value, ... 
,Start_Value,Stop_Value,Worst_Value, ... 

... 

N,rOutput Rank,Start_Value,Stop_Value,Worst_Value, ... ,GPIB_Response Value, ... 
,Start_Value,Stop_Value,Worst_Value, ... 

The first and second lines are the header of a file, and the third line or 
below contains all the measurement result for the spec sheet. The 
following parameters are included in the file: 

 Index: The number of measurement for the spec sheet. 
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 ModeX-PathY: The tag namme of the measurement path for the 
specific mode in a spec sheet. 

 Output Rank: The output rank value for the spec sheet. See Rank for 
the details. 

 Start Value: The measured value at the start frequency for the 
measurement path. 

 Stop Value: The measured value at the stop frequency for the 
measurement path. 

 Worst Value: The worst value in the measured frequency range for 
the measurement path. See Worst Value for the details. 

 GPIB Response Value: The measured value that is imported from an 
external peripheral by a GPIB command. The result value is inserted 
at the end of results for a measurement mode. The query command 
is shown in the header with the GPIB address of the used peripheral. 

All the measurement values of a single DUT are summarized in one line. 
When multiple measurements are performed for a spec sheet, the multiple 
measurement results in additional lines are included in the file. 

As the measurement value at the start/stop frequency is not available for 
the measurement type such as “mean” or “ripple”, no data is recorded in 
the start/stop values for the path. 

 Even when the measurement for a spec sheet is 
skipped by the Skip button in the All Spec Sheets Measurement 
Window, the result is recorded in the file as well. However, the 
output rank is fixed to -1 and no measured values are recorded 
for the start/stop or worst values. 

When "Output Start/Stop value" is disabled by the Lot Input Window in 
advance of the measurement, the contents of the output is shown below: 

Measurement result by spec sheet (start/stop value: OFF) 

"Index","Rank","Mode1-Path1",,,"Mode1-Path2",,,"[GPIB**Address]GPIB Command", ... ,"ModeX-
PathY",, 

1,Output Rank,Worst_value, ... ,GPIB Response Value, ... ,Worst_Value, ... 

2,Output Rank,Worst_value, ... ,GPIB Response Value, ... ,Worst_Value, ... 

... 

N,Output Rank,Worst_value, ... ,GPIB Response Value, ... ,Worst_Value, ... 

Controlling the Back-End Application From An External PC 

The procedure for controlling the back-end application from an external PC 
is described below. 
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1. Send the following commands to the E5071C via GPIB. 

DISP:WIND1:TITL:DATA (Command Parameter) 

The following command parameters are available with the MWA. 

Command Parameter 

cmd_para 
function 

Argument 1 Argument 2 Window that 
accepts the 
command 

cmd_read Group file name 
(.ssg) or spec 
sheet name 
(.mwa) 

  Main Window 

cmd_clear -   Main Window 

cmd_begin Lot name Parameters in the Lot 
Input Window. For more 
details, refer to 
Measurement Procedure 
(All Spec Sheets 
Measurement Window) 

Main Window, 
Measurement 
Window 

cmd_initiate -   Measurement 
Window 

cmd_skip -   Measurement 
Window 

cmd_settings Correction 
values, Manual 
measurement 

  Measurement 
Window 

cmd_end -   Measurement 
Window 

Each of the cmd_para functions as follows. 

cmd_para 
functions 

Description Corresponding 
buttons 

cmd_read Reads the group file or spec sheets 
specified by the argument 1. If you send 
this command when no file exists or no 
more files can be read, an error occurs. 

To specify multiple spec sheets, specify 
spec sheets separated with commas when 
assigning an argument 1 in Step 2. 

Main Window 

Add Spec Sheet Group 

cmd_clear Clears all spec sheets that are currently Main Window 



Measurement with Option 

599 

read. Clear All Groups 

cmd_begin Displays the All Spec Sheets Measurement 
Window, specifying a lot name of the DUT 
by using argument 1. 

Argument 2 specifies the option for the 
measurement (the same setup in the Lot 
Input Window). For more details, refer to 
Measurement Procedure (All Spec Sheets 
Measurement Window). For each option, 
refer to that page. 

 Output Start/Stop Values 

The same as Start/Stop values. Specifies 0 
(OFF) or 1 (ON). 

 Correction values 

The same as Correction (Limit Test). 
Specifies 0 (OFF) or 1 (ON). 

 Manual Measurement 

The same as enable Manual Measurement. 
Specifies 0 (OFF) or 1 (ON). 

 Overwrite Output File 

The same as Overwrite Output File. 
Specifies 0 (OFF) or 1 (ON). 

 Max Fail Rank 

The same as max fail rank (1-255). 
Specifies the value from 1 to 255. 

If you send this command when each 
measurement window is displayed, a 
summary of the results is generated to a 
file, the current measurement is closed, 
and the All Spec Sheets Measurement 
window opens with a new lot name. 

Main Window 

Measurement 

All Spec Sheets 
Measurement 
Window 

New Measurement 

cmd_initiate Initiates measurement immediately. All Spec Sheets 
Measurement 
Window 

Manual Trigger 

Measurement by 
Spec Sheet Window 

Manual Trigger 

cmd_skip Skips the measurement of the next spec 
sheet. 

All Spec Sheets 
Measurement 
Window 

Skip 
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cmd_settings Changes the option of correction values 
and manual measurement during the 
measurement. For correction values and 
manual measurement, refer to the 
descriptions of cmd_begin. 

None 

cmd_end Outputs summary of the results and 
returns to the Main Window. 

All Spec Sheets 
Measurement 
Window 

End Measurement 

2. If it is necessary to set the argument for a command, the following 
command is required before sending the command in Step 1. If each 
argument has several items, set all the parameters separated by a 
comma (,). 

 Setting command of Argument 1 

DISP:WIND2:TITL:DATA parameter 

 Setting command of Argument 2 

DISP:WIND3:TITL:DATA parameter 

For example, to start new measurement using the lot name "lot_gsm001," 
send the following command. In the following example, the output 
start/stop value and overwrite output file are turned ON and the max fail 
rank is set to 100. 

10 output 717;"DISP:WIND2:TITL:DATA lot_gsm001" 
20 output 717;"DISP:WIND3:TITL:DATA 1,0,0,1,100" 
30 output 717;"DISP:WIND1:TITL:DATA cmd_begin" 

 If you send a command with incorrect arguments, 
the command is not executed. 
 
When the command process finishes, the return value of 
DISP:WIND1:TITL:DATA? becomes "cmd_done" If you want to 
wait for the command process to finish, confirm this by whether 
the returned value of DISP:WIND1:TITL:DATA? is "cmd_done" 

Operation of Handler I/O Port by MWA 

A list of pins of the handler I/O operated by the MWA is shown below. The 
signal notations in the parentheses correspond to those of the E5071C. For 
details, refer to I/O Signal Pin Layout and Description. 

Pin 
number 

Signal Name 
in MWA 
(signal name 
in normal 
mode) 

Direction of 
signal 

Description 
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2 /INPUT 

(/INPUT1) 

Input When a negative pulse is applied to 
this pin, the level of the signal 
/OUTPUT1 becomes Low. 

3 /INIT 
(/OUTPUT1) 

Output When a negative pulse is applied to 
pin 2, the level of /OUTPUT1 
becomes Low. 

The back-end application monitors 
/OUTPUT1 and when it turns Low, 
starts measurement. /OUTPUT1 
returns to High at the start of a 
measurement. 

In addition, the 
"CONT:HAND:OUTP1:DATA 1" 
command can be used to set the 
signal level to Low or High. 

5 /RANK A0 

(/PORT A0) 

Output Outputs the minimum rank value for 
the measurement. The output rank is 
the 8-bit value (0-255) with A0 as 
LSB and A7 as MSB. 

/PORT A0 is bit 0 of the output rank. 

6 /RANK A1 

(/PORT A1) 

Output Bit 1 of the output rank. 

7 /RANK A2 

(/PORT A2) 

Output Bit 2 of the output rank. 

8 /RANK A3 

(/PORT A3) 

Output Bit 3 of the output rank. 

9 /RANK A4 

(/PORT A4) 

Output Bit 4 of the output rank. 

10 /RANK A5 

(/PORT A5) 

Output Bit 5 of the output rank. 

11 /RANK A6 

(/PORT A6) 

Output Bit 6 of the output rank. 

12 /RANK A7 

(/PORT A7) 

Output Bit 7 of the output rank. 

13 /FAIL 

(/PORT B0) 

Output If the limit test fails, /PORT B0 
becomes enabled (Low level). If the 
output rank value (/PORT A0 - /PORT 
A7)is 0 (which corresponds to the 
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pass for all measurements), /PORT 
B0 becomes disabled (High level).  

This signal transits after the output 
/RANK (/PORT A0 to A7) transition, 
but transits almost the same timing 
of the /INDEX (/PORT B4) transition. 
Be sure to check /FAIL with some 
delay after /INDEX transition. 

17 /INDEX 

(/PORT B4) 

Output A signal that indicates the end of 
measurement. 

The signal transits after the output 
rank (/PORT A0 - /PORT A7) 
transition. 

The back-end application sets /PORT 
B4 back to inactive (High level) at 
the start of measurement. 

19 /INDEX_SUB 

(/PORT B5) 

Output A reserved signal pin with the same 
function as /PORT B4. Either pin can 
be used. 

22 /SKIP 

(/PORT C0) 

Input/Output This is a skip signal. 

If /PORT C0 is enabled (Low level) 
before measurement, the 
measurement is not performed and 
the status shifts to the mode of 
waiting for the next measurement. 

Timing chart of handler I/O ports by the MWA 
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Error messages in the Back-End Application 

While working with MWA, an error message may appear due to improper 
E5071C settings. This section explain the various error messages and the 
method to avoid these errors. 

  

Error Message Description 

Channel Max This error message appears if the total number channels 
required for a spec sheet (.mwa) is more than the number of 
channels set in the E5071C. 

 This error can be avoided by increasing the 
maximum number of channels in E5071C. Refer to 
Setting Upper Limits of Number of 
Channels/Traces. 
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Configuration and 
test set are 
mismatched. 

This error message appears if the configuration of the test set 
specified in a spec sheet (.mwa) generated by the Front-End 
Application is different from the test set that is being connected 
to the E5071C. 

This error can be avoided by changing the configuration of the 
Multiport Test Set sheet in the Front-End Application. For more 
info, refer to Selecting Test Set. 

  

This error may appear if: 

 The configuration in a spec sheet is for the E5091A 
(E5092A), but the E5092A (E5091A) is connected to the 
E5071C. 

 The configuration in a spec sheet is with the multiport 
test set (E5091A or E5092A), but no test set is 
connected to the E5071C. 

 The configuration in a spec sheet is "None" (no test set), 
but the test set is connected to the E5071C. 

GPIB Error This error message appears if the GPIB address of peripherals 
connected to the E5071C is different from what you specified in 
the GPIB sheet of the front-end application. 

Invalid number of 
point 

This error message appears if the maximum number of points 
required for a spec sheet (.mwa) is more than the number of 
points set in the E5071C. 

 This error can be avoided by increasing the 
maximum number of channels in E5071C. Refer to 
Setting Upper Limits of Number of 
Channels/Traces. 

Invalid Trace This error message appears if the maximum number of traces 
required for a spec sheet (.mwa) is more than the number of 
traces set in the E5071C. 

 This error can be avoided by increasing the 
maximum number of channels in E5071C. Refer to 
Setting Upper Limits of Number of 
Channels/Traces. 
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Measurement Example of a Multiport Switch 

 Overview 

 Device Under Test (DUT) 

 Required Equipment 

 Measurement Parameters 

 Measurement Steps 

Other topics about Measurement Wizard Assistant 

Overview 

This section describes how to measure a multiport switch using the MWA 
software on the E5071C. The measurement conditions for this 
measurement example are those suitable for a SP9T multiport switch. To 
measure another device under test (DUT), change the measurement 
conditions to suit the particular DUT. 

Device Under Test (DUT) 

The DUT adopted in this example is a sample SP9T switch with the 
following configuration and should be connected to the E5092A with 10-
port full crossbar configuration: 
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DUT Port Name Port Number Test Set 

ANT 1 5COM 

Tx1 2 8COM 

Tx2 3 6COM 

TRx1 4 9COM 

TRx2 5 7COM 

TRx3 6 10COM 

Rx1 7 1D 

Rx2 8 2D 

Rx3 9 4D 

Rx4 10 3D 

Required Equipment 

The following test equipment is required for this example: 
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 E5071C (4-port ENA; option 48x or 4K5) with the firmware rev 9.0.0 
or later 

 E5092A Configurable Multiport Test Set (option 020) 

 RF cables (for the connection between the DUT and the test set) 

 Control line cable 

Measurement Parameters 

The sample DUT adopted in this example is a SP9T (Single-pole, 9-throw) 
10-port switch. Transmission measurement for this switch should be 
performed for all the transmission paths between arbitrary ports, and 
reflection measurement for all ports of the DUT. The output port of the 
DUT is selected by 4-bit logic control DC voltage (2.8V as high and 0V as 
low). 

The truth table for the sample switch is as follows: 

  Group A Group B 

Connected 
Path 

Vc1 Vc2 Vc3 Vc4 Vc1 Vc2 Vc3 Vc4 

Tx1 H L L L H L L L 

Tx2 L H L L H L L L 

TRx1 H H L L H L L L 

TRx2 L L H L H L L L 

TRx3 H L H L H L L L 

Rx1 L H H L H L L L 

Rx2 H H H L H L L L 

Rx3 L L L H H L L L 

Rx4 H L L H H L L L 

Measurement Steps 

The measurement for the sample switch will be done using the front-end 
and the back-end applications of the MWA software. The measurement 
procedure is: 

1. Generate a spec sheet (.mwa) with the MWA front-end application. 

2. Copy the spec sheet on the ENA directory 
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3. Import the spec sheet with the MWA back-end application. 

4. Perform necessary calibration measurement by calibration wizard in 
the back-end application. 

5. Connect the DUT with the test set (RF cables, control lines) 

6. Perform measurement with the back-end application. 
Front-End Application 

The Front-end application consist of six sheets in which data for the sample 
switch will be entered as per the switch specifications. This sheet can be 
run on a normal PC: 

1. Multiport Test Set sheet 

Select a configuration of “E5092A X-10-Port” for 10-port full crossbar 
measurement. 
 

 
2. DUT sheet 

Define the port name of the DUT and the connection with the multiport test 
set. 
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3. Mode sheet 

Control logic voltage (Vc1 to Vc3) of the control line group A is applied to 
the DUT (logic A to C) and Vc4 is used for power supply of the DUT. 

 
4. GPIB sheet 

The SCPI commands can be sent to peripherals connected to the ENA via 
GPIB. 

5. Spec Sheet sheet 

Transmission measurement is performed between all paths for each 
operation mode of the DUT. 
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6. Output sheet 

A spec sheet is generated by selecting the “Save Spec Sheet” button in the 
sheet. The traces are allocated automatically in measurement channels. 
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Back-End Application 

The Back-end application is installed on the E5071C in which the data in 
mwa file will be imported as per follows: 

1. Importing a spec sheet 

Select “Add Spec Sheet Group” in the main window, and select “Add Spec 
Sheets..” in the displayed window. 
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2. Performing calibration 

Do a series of calibration measurement by following “step-by-step” 
calibration wizard. 
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3. Connect the DUT and the test set 

The connection between the DUT and the multiport test set is indicated in 
the connection check window. 

 
4. Performing measurement 
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Overview and Restrictions of Group 

 Overview of Group Function 

 Restrictions of Group Function 

 Active Group 

 Relationship between Group File and Status File 

 Process Flow 

Other topics about Measurement Wizard Assistant 

Overview of Group Function 

The back-end application has a "Group" function that enables multiple 
measurements using spec files. 

For the back-end application, the following information items are gathered 
together as a group. 

 Multiple spec files 

 E5071C settings (status file) 

Each group requires a group file (extension: ssg) that has links to files 
associated with each group file as shown in the following figure. The group 
file has no information on the contents of spec files nor the E5071C 
settings but has link information to those files. 

 If there is no linked file, an error occurs in the 
process of recalling the group file. 

Concept of Group and Link 



E5071C 

616 

 
Restrictions of Group Function 

Restrictions on using the group function are given below. 

 A maximum of 10 groups can be defined at a time. 

Because the MWA can use up to 10 spec files, assuming one spec file is 
assigned to each group, the maximum number of groups that can be 
recalled at a time is 10. 

 The file name of a spec file used in one group cannot be used for 
spec files of other groups. 

The MWA cannot recall spec files of the same name at one time, so groups 
that have spec files of the same name cannot be recalled simultaneously. 

 The maximum number of channels for each group is the same as 
that of the E5071C. 

Because the status file associated with the group is recalled with the 
E5071C, the maximum number of channels for one group is limited to that 
of the E5071C. 
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Active Group 

Each group may have a quite different E5071C state, so it is necessary to 
know which group's state is indicated by the current E5071C status. 

This "current E5071C state" is called the "active group." The E5071C keeps 
the same settings as the active group. 

To change the active group, select the radio button to the left of the spec 
file name displayed in the main window. 

If a group file contains more than two spec files, select the spec file at the 
top of the group. Other spec files are grayed-out and cannot be selected. 

When the active group is changed, the E5071C state also changes. This 
means that the status file associated with each group is recalled by using 
the E5071C recall function. 

 The recall process of the E5071C takes a certain time, as does 
changing the active group. 

The calibration wizard function and the status file save function are 
executed for the active group. When running the calibration wizard with 
multiple groups recalled, the calibration is performed for the current active 
group. When you need to calibrate other groups, change the active group 
and run the calibration wizard function again. This process must also be 
done for the status file save function. 

 The active group functions during the measurement. You need 
to switch the active group in order to measure other groups. When 
multiple groups are recalled, however, the active group automatically 
changes when the group is changed. 

Relationship between Group File and Status File 

One status file is associated with each group. To ensure smooth use of the 
MWA, read the following information on the status file. 

Relationship between Group File and Status File 

The results of the calibration wizard function and the E5071C settings are 
recorded and saved in "The status file associated with the group" when the 
Save State button is pressed. The status file is recalled when the active 
group changes. 

 The status file is recalled without confirmation of the file name. 
Also, the file is overwritten without confirmation. 

The timing of saving and recalling the status file is given below. All 
processes are executed for the status file associated with the group. 

1.   Timing of saving the status file 

 When the group is recalled (after the contents of the spec files are 
input to the E5071C). 
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 When the calibration wizard function is terminated 

 When the Save State button is pressed. 

2.   Timing of recalling the status file 

 When the group is recalled (before the contents of the spec files are 
input to the E5071C). 

 When the active group changes. 
Cautions for Status File 

You may have a trouble if the recalled channel/trace setting is different 
from the current channel/trace setting. 
This is because the status file is overwritten in the following process. 

1. Recall the status file when recalling the group. 

2. Recall fails. 

3. The E5071C enters the preset state when the recall fails. 

4. Recall the spec file. 

5. Change the E5071C state according to the contents of the spec file. 

6. Write the E5071C state in the status file. 

For example, assume the following conditions: 

 The setting of the status file is correct other than the channel/trace 
setting of the E5071C. 

 The calibration is performed normally. 

Recall of this status file fails because it differs from the channel/trace 
setting of the current E5071C, and then the E5071C enters the preset 
state. At this time, the calibration data are discarded. 

In process 6, the status file associated with the group is saved. However, 
this file name is the same as the original status file name in process 1; 
therefore, the original status file is overwritten with the contents of "preset 
state and the settings in accordance with the spec file." The original 
calibration data are lost as well. 

To prevent this from happening, a confirmation dialog is displayed between 
the processes 3 and 4. Confirm the ENA setting when you fail to recall the 
status file. 
  

Process Flow 

This section describes the process flow of three states when using the 
back-end application. 

Process flow when recalling the spec file 

The process flow when recalling spec files is shown below. When using 
multiple groups, this process is repeated for the number of groups. 
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Process flow when recalling the spec file 

 
 During recalling the status file after the OK button is 

pressed, if the status file associated with the group does not 
exist, the process goes to the next step, "Recall the spec 
sheets." There is no intermediary process that changes the 
E5071C settings such as preset. 

  

Process flow before the measurement 

The process flow before measurement is shown below. 

Process flow before measurement 
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The following five steps are required before starting measurement. 

1. Recall spec files (group file) 

2. Set up the display with the Minimize function and save the state with 
the Save State button. 

3. Connect a connector to the calibration edge while checking the 
connection information screen. 

4. Perform calibration with the calibration wizard function. 

5. Connect a DUT to the calibration edge while checking the connection 
information screen. 

The display setup and calibration are performed to the current active 
group. If you use the multiple groups, you need to setup the display and 
perform the calibration for each group by changing the active group with 
the radio button. 

As written in Relationship between Group File and Status File and Cautions, 
before recalling the spec files of each group, the status file associated with 
the group is recalled. Therefore, the display setup and the calibration data 
remain the same as the last time, and thus you can skip this process from 
the next time. 
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 It is recommended that you perform calibration 
every time. 

Process flow during the measurement 

The process flow for a single group is shown below. 

Process flow during the measurement (single group) 

 
In this example, three spec files are used, but the process is the same 
even if there is only one spec file. 
  

The process flow for multiple groups is shown below. The following figure 
shows the state where State File 1 had been recalled when starting the 
measurement and the trigger makes each measurement. 

Process flow during the measurement (multiple groups) 
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When measuring multiple groups, the active group switches at the 
following timing. 

 After measuring Channel 6-9 of Group 1, the MWA becomes "the 
Waiting for Trigger" state. When a trigger is generated, the active 
group switches to Group 2. 

 After measuring Channel 5-6 of Group 2, the MWA becomes "the 
Waiting for Trigger" state. When a trigger is generated, the active 
group switches to Group 1. 

Even after measurement of the last sheet of each group, the active group 
does not switch to the next group. Since you can switch on/off each spec 
file during the measurement, if all sheets in the group are off, you do not 
have to activate the group. 

If both Spec Sheet 4 and 5 are off, it is not necessary to move to Group 2, 
and the measurement of Spec Sheet 1 can be started without recalling 
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State File 2. This process is the same as that of measuring the single group 
previously described. 
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Enhanced Time Domain Analysis 

Enhanced Time Domain Analysis (Option TDR) 

 Overview 

 Setting Up Measurement (Setup Tab) 

 Making Measurements 

 Eye Diagram and Mask Test (Eye/Mask Tab) 

 Storing Data and Setting 

 Advanced Waveform Analysis 

 Advanced Mode  

 Measurement Examples 

Programming 

 Option TDR Remote Control 

 Option TDR Command Reference 

Other topics about Measurement with Options 
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Overview 
Overview 

 Features 

 TDR Quick Start 

 TDR Screen Area 

 Consideration of E5071C-TDR Measurements 

 Starting and Exiting TDR Application 

Other topics about Enhanced Time Domain Analysis 
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Features 

Agilent E5071C Option TDR provides the following features: 

 Up to 20 GHz (Option 2K5/4K5) of bandwidth with 22.3 ps (10%-
90%) or 15.9 ps (20%-80%) rise time enables measurement on the 
latest high speed serial standards. 

 Wide dynamic range to observe the true performance of the DUT 

 Low noise floor for accurate and repeatable measurements 

 Fast measurement speed for real-time analysis 

 State-of-the art calibration techniques reduce measurement errors 

 Automatic deskew ensures easy removal of fixture and probe effects 

 Full calibration available for the utmost in measurement accuracy 

 Quickly obtain accurate TDR/TDT and S-parameter measurements 

 Easily locate source of loss, reflections and crosstalk by simultaneous 
analysis of both time and frequency domain 

 Single connection forward and reverse transmission and reflection 
measurements 

 All possible modes of operation (single-ended, differential and mode 
conversion) 

 Measure just the device by utilizing advanced calibration techniques 
to remove cable, fixtures and probe effects 

 Gain insight into high speed interconnect performance through 
simulated eye diagram analysis and manual scale of eye diagram. 

 Apply industry standard (PRBS, K28.5) or used specified patterns 
using the virtual bit pattern generator 

 Pre-defined masks for many high speed serial standards 

 No need for pulse generators as the eye diagram is synthesized from 
measurement results 

 Hot TDR measurement which allows TDR measurement to be 
performed while the device is powered ON.  

See http://www.agilent.com/find/ena_tdr for more information. 

Other topics about Overview 



Measurement with Option 

627 

TDR Quick Start 
TDR Quick Start 

TDR Quick Start helps you to understand the E5071C-TDR option's 
operation quickly. 

 TDR/TDT Measurement 

 Simulated Eye Diagram 

Other topics about Overview 
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TDR/TDT Measurement 

To better understanding how to use the E5071C-TDR option, this section 
describes the basic TDR/TDT measurement procedure using the E5071C. 

Operation procedure 

1. Connect 3.5 mm SMA cables to all test ports. 

2. Click the Setup tab. 

3. Click the Setup Wizard (under Basic) at Setup area. 

4. Set the measurement condition using the Setup Wizard: 

a. Select Deskew & Loss Compensation (under Error Correction) 
and click Next >. 

b. Click the Differential 2-Port button, and click Next >. 

c. Click the Deskew button, and click Next >. 

d. Connect a Thru between Port 1 and Port 3. Click the Measure 
button, and click Next >. 

e. Connect a Thru between Port 2 and Port 4. Click the Measure 
button, and click Next >. 

f. Connect a Load to Port 1 and click the Port 1 button to measure 
the Load. Repeat this step for Port 2, Port 3 and Port 4. When 
finish, click Apply to save the measurement. Click Next >. 

g. Connect the DUT to cables. Click the Measure button, and click 
Next >. 

 
a. Set the Rise Time to "35 ps" and select "10-90%" from the 

Definition drop-down list. When finish, click Apply to save the 
settings. 

b. Click the Finish button. 

5. Click the Auto Scale button. 

6. Select All Traces from the drop-down list.  

7. Select Trace 3. 

8. Click the Marker Search button. 
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9. Select Rise Time (10-90%) from the drop-down list. 

Expected result 

Trace 1 shows the TDR measurement in terms of impedance and Trace 3 
shows TDT measurement in terms of voltage. The rise time of Trace 3 will 
be shown. 

 

Other topics about TDR Quick Start 
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Simulated Eye Diagram 

This section describes the procedure of simulated eye diagram using the 
E5071C with TDR option. 

Operation procedure 

1. Connect 3.5 mm SMA cables to all test ports. 

2. Click the Setup tab. 

3. Click the Setup Wizard (under Basic) at Setup area. 

4. Set the measurement condition using the Setup Wizard: 

a. Select Deskew (under Error Correction) and click Next >. 

b. Click the Differential 2-Port button, and click Next >. 

c. Click the Deskew button, and click Next >. 

d. Connect the DUT to cables. Click the Measure button, and click 
Next >. 

e. Set the Rise Time to "35 ps" and select "10-90%" from the 
Definition drop-down list. When finish, click Apply to save the 
settings. 

f. Click the Finish button. 

5. Click Trace button at the tool bar and select "3" to activate Trace 3. 

6. Click Eye/Mask tab. 

7. Under the Bit Pattern tab: 

a. Select "PRBS" from the Type drop-down list. 

b. Select "2^7-1 bits" from the Length drop-down list. 

c. Set the One Lv. (amplitude) to "200 mV". 

d. Set the Data Rate to "1 Gb/s". 

8. Click the Draw Eye button under Eye Control. 

Expected result 

Eye diagram (Trace 3) appears at the graph window. 
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Other topics about TDR Quick Start 
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TDR Screen Area 

TDR screen area appears at the bottom of the standard E5071C screen. 

 
Graph Area 

The results of measurements such as Time Domain, S-Parameter, and Eye 
are displayed here. Operation with mouse is accepted. 

Setup Wizard 

Using Setup Wizard 
Instrument Status Bar 

Instrument Status Bar 
Channel Window 

In addition to the standard E5071C status bar, there's TDR indicator at the 
right corner of the channel window. This indicator is turned ON only when 
TDR option is turned ON. The TDR indicator is blue in basic mode and 
changes to yellow when advanced mode is turned ON. This indicator also 
changes according to the Cal status, as shown in the following: 

Cal Indicator 

Off TDR 

Deskew TDR 
[Deskew] 
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DLC TDR 
[DLC] 

ECal TDR [Full] 

ECal&Deskew TDR 
[Full+] 

  

Others Indicator 

Hot TDR Mode TDR ? 

Tool Bar 

Frequently used standard E5071C functions are displayed here. These 
functions are synchronized with E5071C-TDR options and modes. 

 

No Functions Details 

1 About E5071C-
TDR 

About E5071C-TDR 

2 Active Trace Setting up Parameters on 
Each Traces 

3 Auto Scale Using Scale/Zooming 

4 Run Controlling Trigger 

5 Stop/Single Controlling Trigger 

6 Data Mem Using Data/Memory 

7 Marker Using Marker/Marker Search 

8 Marker Search Using Marker/Marker Search 

9 File Storing Data and Setting 

10 Minimize Minimizes the Setting Area. 
Only tool bar is displayed. 

11 Help Executes E5071C-TDR Online 
Help 

12 Exit Exiting E5071C-TDR 
application GUI 
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 Buttons 1 to 5 and 9 to 12 are always displayed regardless 
of the selected mode. Button 6 to 8 does not appear in the Eye 
mode, and the measurement parameter is displayed on the surface 
of Button 3 (instead of Auto Scale). 

About E5071C-TDR 

Click this first icon on the tool bar and the About dialog box appears. 
Mode Selector 

You can selected one of the three available E5071C-TDR modes: 

 Setup 

 TDR/TDT 

 Eye Mask 

The mode changes when one of these tabs are selected. Once selected, the 
mode is highlighted. The displayed setting area changes corresponding to 
the selected mode.  

Setting Area 

The setting area changes and is displayed according to the selected mode.  

Other topics about Overview 
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Consideration of E5071C-TDR Measurements 

 Channel and Trace Concepts 

 Device Under Test (DUT) Considerations 

 Test Cable and Connector Considerations 

Other topics about Overview 
Channel and Trace Concepts 

It is important for oscilloscope users to note the difference in the concept 
of channel in oscilloscope and network analyzer.  

In network analyzer, channel is referred to the window for displaying 
traces. Because a channel corresponds to a window, it is called a channel 
window.  

On the other hand, the points on the front panel of network analyzer where 
cables and DUTs are connected are called test ports. These test ports are 
not channels and do not directly associate with channel windows.  

The E5071C, for example allows you to use up to 160 channels (when the 
number of traces is up to 9) to perform measurement under 160 different 
stimulus conditions. 

For each channel, up to 4, 6, 9, 12 or 16 traces (measurement 
parameters) can be displayed. Because multiple traces can be displayed for 
each channel, no feature is provided to link the stimulus conditions 
between channels, and each channel is always independent of the others. 
In other words, for the E5071C, you need to set the measurement 
conditions and execute calibration for each channel you use for 
measurement.  

To learn more about setting the channel and traces in E5071C, refer to 
Setting Channels and Traces.  

Enhanced Time Domain Analysis option allows you to use channel 1 only. 
Up to 16 traces can be displayed in this option (when Differential 2-Port 
DUT topology and all T or all S traces are selected).  

Device Under Test (DUT) Considerations 

Maximum DUT Lengths 

Refer to the technical overview 
(http://cp.literature.agilent.com/litweb/pdf/5990-5237EN.pdf) for 
maximum DUT lengths  

To convert from DUT length in seconds to distance in free space, multiply 
the value in time by c, the speed of light in free space. To calculate the 
actual physical length, multiply this value in free space by Vf, the relative 
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velocity of propagation in the transmission medium. (Most cables have a 
relative velocity of 0.66 for a polyethylene dielectric or 0.7 for a PTFE 
dielectric.)  

DUT length (m) = DUT length (s) × c × Vf 

AC coupled (DC cut) DUTs 

Caution is required when measuring AC coupled (DC cut) DUTs. 

The response after the capacitor cannot be measured correctly, because 
the capacitor response overlaps the response from the input and may 
cause measurement errors. 

When measuring AC coupled devices, make sure that the following two 
conditions are satisfied for proper measurements.  

 Capacitance should be equal to or greater than 10 nF  

 DUT length should be equal to or less than 6.25 nsec (1.25 meters at 
ε=2.25)  
 
DUT length is an actual length of DUT, not "DUT Length" in the Setup 
Tab in the TDR GUI. 

When the above conditions are not satisfied, either: 

 Short circuit the capacitor 

 Provide open termination at one end of the capacitor and measure 
from the opposite side. 

Test Cable and Connector Considerations 

Using high quality cables to connect the DUT is recommended in order to 
minimize measurement degradation. The cables should have low loss, low 
reflections, and minimum performance variation when flexed.  

Refer to the technical overview 
(http://cp.literature.agilent.com/litweb/pdf/5990-5237EN.pdf)  for 
maximum test cable lengths. 

 When performing deskew and loss compensation, the 
same type of cable must be used for all test ports, but they do not 
necessarily have to be of the same length. 
 
When performing deskew or deskew and loss compensation, use a 
single connector interface type, such as SMA, or Type-N, for all of 
the ports to obtain the best results. 
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Starting and Exiting TDR Application 

 Starting TDR Application 

 Exiting TDR Application, GUI (Graphical User Interface) 

Other topics about Overview 

Ensure that TDR application is installed and E5071C-TDR option is enabled. 
Starting TDR Application 

 Click Analysis > TDR to turn on the TDR. The E5071C application 
restarts. 

Exiting TDR Application, GUI (Graphical User Interface) 

1. Turn on the Advanced Mode. 

2. Click Analysis > TDR to turn off the TDR application. The E5071C 
application restarts. 

Click on the X button on E5071C-TDR application GUI to close it. However, 
the E5071C-TDR application (MODE) is not exited unless you turned off 
Analysis > TDR. You can restart the E5071C-TDR application GUI by 
clicking on the Analysis > Start TDR key. 
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Setting Up the Measurement 
Setting up Measurement 

 Using Setup Wizard 

 Performing Manual Setup 

 Performing Error Corrections 

Other topics about Enhanced Time Domain Analysis 
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Using Setup Wizard 

 
Setup Wizard guides you to perform the Enhanced Time Domain Analysis 
measurement setup step-by-step. The wizard appears automatically the 
first time you execute the Enhanced Time Domain Analysis option. If you 
check the Show this wizard next start-up option, the setup wizard will appear 
automatically in the next start-up as well. 

  

Another option to start up the Setup Wizard is from the Setup tab: 

1. Click the Setup tab. 

2. Click the Setup Wizard button under Basic, as shown below. 

 
3. If you do not want to perform the Enhanced Time Domain Analysis 

setup by using the wizard, click Close to close the Setup Wizard. 
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4. Otherwise, select the type of Error Correction among the available 
options: 

 Deskew 

 Deskew & Loss Compensation 

 Full Calibration (ECal) 

5. If you check the Show this wizard next start-up option, the setup 
wizard will appear automatically in the next start-up. 

6. Click Next > to start the setup process. 

7. Select the topology of the device under test (DUT). 

 
8. Click Next >. 

9. The next screen of the wizard varies depends on the selection of Error 
Correction option and topology of the DUT. 

10. Follow the instruction on the wizard to complete the setup. 

Other topics about Setting Up Measurement 
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Performing Manual Setup 

Besides Using the Setup Wizard,  you can also perform the Enhanced Time 
Domain Analysis measurement setup manually. The manual setup is 
performed at the Setup tab. 

 Preset 

 Selecting DUT Topology 

 Setting Stimulus Amplitude Level 

 Setting DUT Length 

 Performing Error Correction 

 More Functions 

 Average 

 Advanced Waveform 

 Hot TDR 

Other topics about Setting Up Measurement 

 
Preset 

1. Click Preset under Basic to preset the E5071C.  

2. A dialog box appears requesting for confirmation. Click OK to proceed. 

 
3. All the settings shown in the Basic area are changed to default except 

for the DUT Topology. 

 When you click Preset, the calibration and deskew 
data is deleted. Preset sets all of the settings at default except 
for the DUT Type. 

Setting DUT Topology 



Measurement with Option 

643 

1. At the DUT Topology under Basic, select one of the available option 
from the drop-down list box. This is the same function as Step 1/4: 
DUT Topology in the Setup Wizard. 

2. A dialog box appears requesting for confirmation. Click OK to proceed. 

 
 Selecting the DUT topology executes the preset of 

the E5071C. Hence, when you change from one DUT topology 
to another, the calibration and deskew data is deleted.   

Setting Stimulus Amplitude Level 

Stimulus Amplitude Level is the value for scaling the time domain 
measurement result.  

 Stimulus Amplitude Level is not related to the actual 
applied voltage.  

1. Click the text box of Stim. Ampl. (Stimulus Amplitude) under Basic. An 
Entry dialog box appears. Type the stimulus amplitude level value and 
click OK. The new value is displayed at Stim. Ampl.. 

 
Setting DUT Length 

The DUT length setting is used to set the time span for time domain 
measurements. Measurement can be made on longer DUTs, but minimum 
rise time values may be limited. 
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Minimum and Maximum Rise Time Guideline 

The guideline of minimum and maximum rise time for E5071C 3 GHz, 4.5 
GHz, 6.5 GHz, 8.5 GHz, 14 GHz and 20 GHz is outlined below: 

E5071C-235/435 (100 kHz to 3 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%)[ps] 

min rise time 
(20-80%) [ps] 

max rise 
time 
[ps] 

41.8 149 106 2090 

416 149 106 20800 

1250 446 317 62500 

 
E5071C-245/445 (100 kHz to 4.5 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%)[ps] 

min rise time 
(20-80%) [ps] 

max 
rise 
time 
[ps] 

27.9 99.1 70.5 1395 

277 99.1 70.5 13850 
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1250 446 317 62500 

 
E5071C-265/465 (100 kHz to 6.5 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%)[ps] 

min rise time 
(20-80%) [ps] 

max 
rise 
time 
[ps] 

19.3 68.6 48.8 965 

192 68.6 48.8 9600 

1250 446 317 62500 
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E5071C-285/485 (100 kHz to 8.5 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%)[ps] 

min rise time 
(20-80%) [ps] 

max rise 
time 
[ps] 

14.8 52.5 37.3 740 

147 52.5 37.3 7350 

1250 446 317 62500 
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E5071C-2D5/4D5 (300 kHz to 14 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%) [ps] 

min rise time 
(20-80%) [ps] 

max rise 
time [ps] 

8.94 31.9 22.7 447 

89.2 31.9 22.7 4460 

416 149 106 20800 
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E5071C-2K5/4K5 (300 kHz to 20 GHz) 

DUT + 
Cable 
[ns] 

min rise time 
(10-90%) [ps] 

min rise time 
(20-80%) [ps] 

max rise 
time [ps] 

6.26 22.3 15.9 313 

62.5 22.3 15.9 3125 

416 149 106 20800 



Measurement with Option 

649 

 
  

The length of the DUT can be set either automatically or manually.  

Automatic measurement  - recommended 

1. Click Auto at the DUT Length under Basic.  

2. DUT Length dialog box of the Setup Wizard appears. 

3. Click Measure.  

4. The length of the DUT is measured automatically and used to set the 
time base. 

5. Once complete, a check mark appears beside the Measure. 
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 The automatic measurement feature is available as one of 

the steps in the Setup Wizard.  

Manual entry 

If the length of the DUT is known, the DUT length can be set manually.  

1. Enter the DUT length in the DUT length text box under Basic. 

 Any DUT shorter than the DUT length setting can be 
measured. Therefore, when testing multiple DUTs with different 
lengths, set the DUT length using the longest DUT to allow for the 
use of the same instrument settings for all measurements.  

Performing Error Correction 

There are three error correction options available, as stated below. Refer to 
Performing Error Correction for more information. 

 Deskew 

 Deskew and Loss Compensation 

 Full Calibration (ECal) 
More Functions 

Ref. Z 
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1. At the Ref. Z (Port Reference Impedance) under More Functions, left-
click once. An Entry dialog box appears. Type the post reference 
impedance value and click OK. The new value is displayed at Ref. Z. 

Dielectric Const. and Velocity Factor 

Velocity Factor = 1 / sqrt(Dielectric Constant).  

As such, when you change either one, the value of the other changes 
automatically.  

1. To change the value of dielectric constant, at the Dielectric Const. under 
More Functions, left-click once. An Entry dialog box appears. Type the 
Dielectric Constant value and click OK. The new value is displayed at 
Dielectric Const.   

2. The value of the velocity factor is changed in a similar way at Velocity 
Factor under More Functions. 

Source Power 

The signal source level is changed during HOT TDR measurement to avoid 
device malfunction:  

1. At the Source Power under More Functions, left-click once. An Entry 
dialog box appears. Type the source power value and click OK. The new 
value is displayed at Source Power.  

Advanced Mode 

Refer to Advanced Mode. 

Average 

The averaging function allows you to reduce the trace noise. It executes 
the sweep the number of times specified by the averaging factor when the 
sweep averaging function is turned ON. To activate the averaging option, 
go to Average. 

1. To turn ON the averaging factor, select the Averaging check box. 

2. Type the averaging factor (number of times the sweep needs to be 
executed). 

3. To turn ON the averaging trigger, select the Average Trigger check box. 

4. At the IF Bandwidth, left-click once. An Entry dialog box appears. Type 
the IF bandwidth value and click OK. The new value is displayed at IF 
Bandwidth. Reducing IF bandwidth increases the dynamic range. 

Advanced Waveform 
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Refer to Advanced Waveform Analysis. 
Hot TDR 

Refer to Hot TDR Measurement. 
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Performing Error Corrections 

 Overview 

 Deskew 

 Deskew and Loss Compensation 

 Full Calibration (ECal) 

Other topics about Setting Up Measurement 
Overview 

There are many different approaches of removing the effects of the test 
fixture and cables from the measurement. The level of difficulty for each 
error correction technique is related to the accuracy of each method. As 
such, E5071C-TDR gives you the flexibility of selecting the desired error 
correction. 

There are three error correction options available, as stated below: 

 Deskew 

 Deskew and Loss Compensation 

 Full Calibration (ECal) 

If you use the Setup Wizard, you will be guided though step-by-step to 
perform the Enhanced Time Domain Analysis measurement setup. This 
includes performing the error correction. Optionally, you can perform the 
error correction manually, at the Setup tab. 

 
  

 The TDR indicator at the channel window also shows the 
TDR deskew and calibration status. 

Deskew 

Deskew automatically compensates the electrical length of the cables and 
fixtures. Deskew mathematically extends the calibration reference plane to 
the DUT, hence removes the delay from the test setup effectively. This 
error correction technique provides good results if the cable and fixture are 
very well designed. 

 As deskew does not compensate the loss of cables in the 
measurement, cables should be low loss and as reasonably short as 
possible.  
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1. Click the Deskew button under Basic. 

2. Deskew dialog box of the Setup Wizard appears.  

3. Follow the instruction on the wizard and click the Deskew button in the 
dialog box. 

 
5. Deskew is performed and a check mark appears beside the Deskew 

button. 

6. Alternatively, you can deskew one port at a time. To perform this, 
instead of clicking the Deskew button, click the Options button in the 
dialog box. 

7. At the Deskew Option dialog box, you can click one port at a time to 
deskew it.  
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8. Click Measure All to perform deskew on all the ports. This action is the 

same as clicking the Deskew button. You must deskew all the active 
ports.  

9. At Standard Type, select either Open or Short deskew. 

10. Click OK to close the Deskew Option dialog box. 

11. Once complete, click Finish on the dialog box. 
Deskew and Loss Compensation 

Deskew and loss compensation mathematically extends the calibration 
reference plane to the DUT, hence removes the delay and loss from the 
test setup effectively. This error correction technique is a good compromise 
between level of difficulty and accuracy. 

 The same type of cable must be used for all test ports. 
However, they do not necessarily have to be of the same length. 

1. Click the Deskew & Loss button under Basic. 

2. Deskew dialog box of the Setup Wizard appears.  

3. The Deskew & Loss is a three-step process.  

4. Follow the instruction on the wizard and click the Deskew button in the 
dialog box. 
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5. Alternatively, you can deskew one port at a time, just as in Deskew. To 

perform this, instead of clicking the Deskew button, click the Options 
button in the dialog box. 

6. At the Deskew Option dialog box, you can click one port at a time to 
deskew it.  

7. Clicking Measure All performs deskew on all the ports at the same time. 
This action is the same as clicking the Deskew button. You must 
deskew all the active ports.  

8. At Standard Type, select either Open or Short deskew. 

9. Click OK to close the Deskew Option dialog box. 

10. At Step 2, connect a thru between the ports as per the instruction on 
the dialog box and click Measure.  

 Use thru with a short and low loss. 

11. At Step 3, connect a load to the ports one by one and click the 
associate button accordingly. Once complete, click Apply to save the 
measurement. 

12. Click Finish on the dialog box. 
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Full Calibration (ECal) 

Full Calibration refers to calibration using the Electronic Calbration (ECal) 
module. It is a complete solid-state calibration solution, which makes 
calibration fast and easy.  

 2-Port ECal is supported when DUT topology is set at 
Single Ended-1/2 Port, Differential 1 port.   

1. Click the ECal button under Basic. 

2. Full Calibration dialog box of the Setup Wizard appears.  

3. Follow the instruction on the wizard and click the Calibrate button in the 
dialog box. 

 
4. Click Next >. 

5. Fixture Compensation is an optional process.  



E5071C 

658 

 
6. If you choose to perform fixture compensation, follow the instruction on 

the wizard and click the Fixture Comp button in the dialog box. This 
automatically compensates the electrical length of the cables and 
fixtures of all the ports. 

7. Alternatively, you can compensate one port at a time. To perform this, 
instead of clicking the Fixture Comp button, click the Options button in 
the dialog box. 

8. At the Fixture Compensation Option dialog box, you can click one port at 
a time to compensate it.  

9. Clicking Measure All compensates all the ports at the same time. This 
action is the same as clicking the Fixture Comp button. You must 
compensate all the active ports.  

10. At Standard Type, select either Open or Short compensation. 

11. Click OK to close the Fixture Compensation Option dialog box. 

12. Once complete, Finish on the dialog box. 
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Making Measurement 
Making Measurements 

 Setting up Parameters on Each Traces 

 Controlling Trigger 

 Using Scale/Zooming 

 Using Marker and Marker Search 

 Using Data and Memory 

 Using Gating 

 Using Trace Control 

 Hot TDR Measurement 

Other topics about Enhanced Time Domain Analysis 
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Setting up Parameters on Each Traces 

 Selecting Trace 

 Changing Displayed Trace 

 Selecting Parameters 

 Defining the Stimulus 

 Peeling 

 Smoothing 

Other topics about Making Measurement 
Selecting Trace 

Three ways to select the displayed trace: 

Using Mouse 

 Double-click on any area of the graph plot to exit from full view. 

 Click on the desired trace to select the trace. 

Using Hardkey  

1. Press the Trace Max key to exit from full view of the active trace. 

2. Press the Trace Prev or Trace Next key to select the desired trace. 

3. Press the Trace Max key to enter full view. 

Using Softkey 

 Click on the Trace button and select the trace number from the list as 
shown below. 

 The number of trace is changeable and up to 16 traces can 
be displayed in this option. 16 traces are displayed when Differential 
2-port DUT topology, and all T and all S traces are selected. 

 
Changing Displayed Trace 

Changing Displayed Trace 
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Two ways to change the displayed trace: 

Using Mouse 

1. Double-click on the single trace graph window to exit from full view 
of active trace as shown below. 

 
2. Double-click on the desired trace for full view. 

 
Using Hardkey  

1. Press the Trace Max key to exit from full view of the active trace. 

2. Press the Trace Prev or Trace Next key to select the desired trace. 
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3. Press the Trace Max key again to display the desired trace in full 
view. 

Selecting Parameters 

Click on the TDR/TDT tab in order to get to the Parameters selection as 
shown below. 

The table below shows the Measurement and Format available under the 
Parameter setting: 

Measure Format 

S-Parameter 

Log Mag 

Linear 

Real 

Imaginary 

Group Delay 

SWR 

Phase 

Expand Phase 

Positive Phase 

Smith (Lin/Phase) 

Smith (Log/Phase) 

Smith (Re/Im) 

Smith (R + jX) 

Smith (G + jB) 

Polar (Lin/Phase) 

Polar (Log/Phase) 

Polar (Re/Im) 

Time Domain 
Impedance 

Volt 
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Log Mag 

Linear 

Real 

 
The table in the Parameter area changes as the selection of Measure 
changes. The changes can be referred as below: 

Measure Table Content starts with 

S-Parameter Single-Ended S 

  Differential Sc, Sd 

Time Domain Single-Ended T 

  Differential Tc, Td 
Defining the Stimulus 

There are two options to choose from under the Stimulus: 

 Lowpass Step 

 Lowpass Impulse 

Only for the Lowpass Step the selection for Rise Time is active. The two 
options for Rise Time are: 

 10-90% 

 20-80% 

The rise time settings in TDR/TDT mode and EYE/MASK mode are 
independent. 

Peeling 

When a device has two or more impedance discontinuities, reflections from 
the second discontinuity reflects off the first discontinuity. This complex 
interaction of secondary reflections from the stimulus pulse compromises 
the measured impedance profile and decreases the measurement 
performance.  

TDR peeling compensates for the complicated interaction between the 
discontinuities. TDR peeling analysis reflects the signals at the source and 
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de-convolves the time domain reflections to create an impedance profile of 
the device being tested. This option is available when the measurement 
parameter is set to time domain reflection and the format is impedance. 

Limitation 

 TDR peeling does not account for frequency response losses (for 
example, PC board transmission lines are lossy devices). The sum of 
the waves that are incident on a node are assumed to be equivalent 
to those exiting the node. 

 TDR peeling assumes a lossless transmission line (resistance of 0). 
Any actual resistance (which causes loss, even at DC) degrades the 
accuracy of peeling. 

 Initial impedance mismatch is the most accurate; as distance 
increases from initial impedance mismatch down the transmission 
line, the impedance accuracy decreases. 

 TDR peeling cannot be used on TDT responses, because the lack of 
reflections invalidates the algorithm. 

How to set Peeling 

1. Click TDR/TDT tab. 

2. Select the Peeling check box under Parameter. 
Smoothing 

Smoothing is only available when S-Parameter is measured and only 
applicable to reflection coefficient only (S11, S22, S33, S44). 

How to set Smoothing 

1. Click TDR/TDT tab. 

2. Select the Smoothing check box under Parameter. 
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Controlling Trigger 
Making Single/Continuous measurement 

Single measurement 

 Click on the Stop Single button to enable single measurement. 

Continuous measurement 

 Click on the Run button to enable continuous measurement. 

 

Other topics about Making Measurement 
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Using Scale/Zooming 

 Using Autoscale 

 Changing Scale Manually 

 Zooming 

Other topics about Making Measurement 
Using Autoscale  

1. Select the trace which you want to change the scale. 

2. Click on the Auto Scale button on the tool bar or right-click in the 
graph plot area. 

3. Select the desired scale. Refer to the table below for the details of 
each selection. 

Scale Details 

Auto Scale X Auto scaling X axis only, on the active trace 

Auto Scale Y Auto scaling Y axis only, on the active trace 

Auto Scale X & Y Auto scaling both X & Y axis, on the active trace 

Auto Scale All Auto scaling both X & Y axis, on all traces 
Changing Scale Manually 

Changing Horizontal Scale 

1. Select the trace which you want to change the scale. 

2. Click the TDR/TDT tab. 

 Using Virtual knob 

a. Click the left knob under Horizontal. The centre of the knob 
turns blue. 

b. Scroll up or down the wheel mouse button to change the scale. 

 Type in Entry box 

a. Click the box below the left knob under Horizontal. An Entry 
dialog box appears. 

b. Type the precise value. 

 Clicking Wave icons 

a. Click the wave icons above the left knob under Horizontal. 
Details are as table below: 
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Function 
Icon 

Details 

 

Click to increase the scale in a 1-2-5 sequence. 
The width of the waveform compresses. The 
default value for basic time units is 1.0 ns/div 

 

Click to decrease the scale in a 1-2-5 sequence. 
The width of the waveform expands. 

  

Reference Position for Horizontal Axis 

The reference point of horizontal axis can be selected from the center line 
or left edge of the displayed graticule. 

Click the icon as shown in table below under Horizontal to change the 
reference point:  

Function 
Icon 

Details 

 

Reference point of the display graticule to the left edge. 
The position of left edge is not changed even if you 
change the scale. 

 

Reference point of the display graticule to the center. 
The position of center is not changed even if you change 
the scale. 

Changing Horizontal position 

1. Select the trace which you want to change the horizontal position. 

2. Click the TDR/TDT tab. 

 Using Virtual knob 

1. Click the right knob under Horizontal. The centre of the knob 
turns blue. 

2. Scroll up or down the wheel mouse button to change the 
position. 

 Type in Entry box 

1. Click the box below the right knob under Horizontal. An Entry 
dialog box appears. 

2. Type the precise value. 

 Clicking Arrow icons 
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1. Click the arrow icons above the right knob under Horizontal. 
Details are as table below: 

Function 
Icon 

Details 

 

Click to increase the delay from trigger; the 
waveform moves to the left of the display. 

 

Click to decrease the delay from trigger; the 
waveform moves to the right of the display. 

  

Changing Vertical Scale 

1. Select the trace which you want to change the scale. 

2. Click the TDR/TDT tab. 

 Using Virtual knob 

1. Click the left knob under Vertical. The centre of the knob turns 
blue. 

2. Scroll up or down the wheel mouse button to change the scale. 

 Type in Entry box 

1. Click the box below the left knob under Vertical. An Entry dialog 
box appears. 

2. Type the precise value. 

 Clicking Wave icons 

1. Click the wave icons above the left knob under Vertical. Details 
are as table below: 

Function 
Icon 

Details 

 

Click to increase the scale in a 1-2-5 sequence; 
the waveform height compress. 

 

Click to decrease the scale in a 1-2-5 sequence; 
the waveform height will expand. 

Changing Vertical Position 

1. Select the trace which you want to change the vertical position. 

2. Click the TDR/TDT tab. 
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 Using Virtual knob 

1. Click the right knob under Vertical. The centre of the knob 
turns blue. 

2. Scroll up or down the wheel mouse button to change the 
position. 

 Type in Entry box 

1. Click the box below the right knob under Vertical. An Entry 
dialog box appears. 

2. Type the precise value. 

 Clicking the Arrow icons 

1. Click the arrow icons above the right knob under Vertical. 
Details are as table below: 

Function 
Icon 

Details 

 

Click to increase the offset value; the 
waveform shift downward. 

 

Click to decrease the offset value; the 
waveform shift upward. 

 Drag and drop 

1. Click and hold the y-axis of the graph plot. 

2. Drag up or down to the desired position and release the 
button. 

Zooming 

To zoom in the graph plot: 

1. Left-click and hold the mouse button. 

2. Drag the area you would like zoom and release the mouse button. 

3. Select zoom as shown below. 
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Using Marker/Marker Search 

 Activating Marker 

 Moving Marker 

 Using Reference Marker 

 Searching Max/Min Points on Trace 

 Measuring Rise Time 

 Measuring Delta Time 

Other topics about Making Measurement 
Activating Marker 

1. Click on the Marker Off button. 

2. Select 1 from the list to activate Marker 1. 

 The marker button shows Marker Off when there is no 
active markers. The marker button shows Marker Ref when reference 
marker is active. This applies to all markers. Active marker has an 
arrow head pointing down. Inactive markers have an arrow head 
pointing up. Only markers 1 and 2 have vertical dotted lines. All 
marker values are displayed at the upper left corner of the graph 
view. There are a maximum of 9 markers that can be activated. 
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Moving Marker 

 Click and hold on the marker, drag the marker to the desired point 
and release the mouse button. 

Using Reference Marker 

When reference marker is used, all 9 markers use reference marker as 
reference point. 

1. Click on the Marker Off button. 

2. Select Ref from the list. 
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Moving reference marker is similar to moving marker. Simply choose the 
reference marker instead of the marker number. 

Searching Max/Min Points on Trace 

Searching Max point on trace 

1. Click on the desire trace. 

2. Click on the Marker Search button. 

3. Select Max from the list. 

Searching Min point on trace 

1. Click on the desire trace. 

2. Click on the Marker Search button. 

3. Select Min from the pull down menu. 

 The marker is constantly on tracking mode when Max or 
Min is selected. Even moving the marker with the mouse, the marker 
tracks the Max or Min of the trace and points to it. 

Measuring Rise Time 

1. Click on the desire trace. 

2. Click on the Marker Search button. 

3. Select Rise Time (10-90%) or Rise Time (20-80%) from the list. 

The data is displayed at the top left corner of the graph plot. 
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Measuring Delta Time 

Delta Time measurement available for Time Domain. Traces other than 
time domain are not able to use for delta time measurement. Delta time is 
compared with trace save in memory, if available, else it is compared with 
the trace selected. 

1. Click on the trace that is the starting point for the Delta Time. 

2. Click on the Marker Search button. 

3. Select Δ Time from the list and select the Δ Time checkbox. 

4. Select the trace that will be the stopping point. 

 The trace of the starting point can not be changed, 
therefore it is selected at the beginning. You can compare Data with 
Memory, by selecting the same trace. (only if Data & Memory is 
selected) 

5. Select the Position to be measured. 
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6. Click on the OK button. 

The data is displayed at the top left corner of the graph plot. 
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Using Data and Memory 

 Storing Data Traces to Memory 

 Display the Memory Traces 

Other topics about Making Measurement 

Data displayed on the graph plot can be stored in the memory and recalled 
for later use. Data traces stored in the memory will be deleted once 
E5071C-TDR option restarts. 

 
Storing Data Traces to Memory 

1. Click on the Data Mem button. 

2. Select Data -> Mem from the list. 
Display the Memory Traces 

1. Click on the Data Mem button. 

2. Select Memory from the list. 

Table below explains other functions in the Data Mem list: 

Function Details 

Data -> Mem Save Data traces to Memory 

Off Display off 

Data Display Data traces only 

Memory Display Memory traces only 

Data & Memory Display Data and Memory traces 
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Using Gating 

 Overview 

 Coupling Gate on Several Traces 

 Setting Start/Stop Points 

 Selecting Gating Type 

 Activating Gate 

Other topics about Making Measurement 
Overview 

Gating provides the ability to observe the effect of a particular circuit 
element on frequency domain response by virtually removing undesired 
responses. When you define a gate on time domain plot, the gated section 
is removed and replaced mathematically with an ideal transmission line 
having the same electrical delay as the removed section. Gating is applied 
to time plots of individual parameters. While gating the time domain plot of 
a parameter, you can observe the effect that gating has on the frequency 
domain of the same parameter by coupling the relevant traces using the 
gate coupling feature. By observing the original frequency domain 
response and the transformed frequency domain response, the effect of 
the gating operation on the S-parameter data can be seen.  

 When a discontinuity in a test device reflects energy, that 
energy will not reach subsequent discontinuities. This can "MASK", or 
hide, the true response which would have occurred if the previous 
discontinuity were not present. The Gating feature does NOT 
compensate for this.  

Coupling Gate on Several Traces 

Gate Coupling allows two or more traces to share the same gating values. 
The gating value of the active trace is coupled to other trace(s). 

It is used to observe the gated frequency response while setting a gate on 
time response. 

Operational procedure 

1. Click the TDR/TDT tab. 

2. Under TDR/TDT, click the Gating tab.   

3. Under Gating, click the Gate Coupling button. 

4. Gate Coupling dialog box appears. 
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5. Select the time domain trace and the associated S-Parameter trace. 

For example, trace of T11 and trace of S11. 

6. Click OK. 

 The gate coupling should not be applied to unrelated 
responses. For example, TDR (T11) and Insertion Loss (S21). 

 Selecting a lot of traces the gate coupling makes the 
response of virtual knobs slow. Type your desired value instead of 
rotating virtual knobs to specify the value.    

Setting Start/Stop Points 

Gating is set on the active trace. There are several methods to set the 
start and stop points of the gate: 

Setting points at gating tab 

 
1. Click the TDR/TDT tab. 

2. Under TDR/TDT, click the Gating tab.  

3. Click on the Start or Stop virtual knob. 

4. The knob is highlighted in blue once its enabled.  
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5. Click on the virtual several times clockwise to increase the value and 

anti-clockwise to decrease the value. 

6. You can observe the start or stop time in the text box below the 
virtual knob and gate markers on the active trace.   

7. Optionally, you can click the text box under the Start or Stop virtual 
knob. 

8. An Entry dialog box appears.  

 
9. Type the start or stop time and click OK.  

10. The new value will be displayed at text box and x-axis of the 
active trace.    

 The Start virtual knob and text box sets the start time and 
the Stop sets the stop time. 

 The start time and stop time should be set at a point on 
which the impedance is close to the reference impedance. 

Setting points at active trace graph plot 

1. On the time domain active trace, drag your mouse across the area to 
set the gating. 

2. Select Set Gating Range. 
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3. You can observe two dashed lines indicating the gate on the graph 

plot. These are gate markers. 

4. You can also observe the time value in the text box below the virtual 
knob under the Gating tab in the TDR/TDT area. 

Moving gate at active trace graph plot 

1. Select the gate marker (dashed line). 

2. Drag the gate marker, with your mouse to a new location. 

3. Release the mouse click, to have the move take effect. 
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Selecting Gating Type 

The Enhanced Time Domain Analysis module allows you to choose from the 
following two gate types: 

Gate 
type 

Description 

Band 
pass 

Removes response outside the gate 
range 

Notch Removes response inside the gate 
range 

Operational procedure 

1. Click the TDR/TDT tab. 

2. Under TDR/TDT, click the Gating tab.   

3. Under Gating, select one of the gating type from the Type area.  
Activating Gate 

Ensure that you have set the start and stop time. Then follow the following 
procedure: 

1. Click the TDR/TDT tab. 

2. Under TDR/TDT, click the Gating tab.   
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3. Under Gating, select the Gating check box.  

Switch Gating State 

1. Right-click on the time domain active trace. 

2. Select Switch Gating State. 

3. If gating was turned ON earlier, this step will turn it OFF and vise 
versa. You can observe the changes in the Gating check box.  

  



Measurement with Option 

683 

Using Trace Control 

 Changing Trace Allocation 

 Coupling Marker/Time 

 Copying Trace Setting 

Other topics about Making Measurement 

 
Changing Trace Allocation 

Changing the trace allocation affects the data display on the graph plot. 
Table below shows the details of each selection: 

Allocation Details 

Mixed 
Display mixed of commonly measured time domain and S-
parameter data 

All T Display all Time Domain data for selected device topology 

All S Display all S-Parameter data for selected device topology 

1. Click the TDR/TDT tab. 

2. Click on the desired trace allocation in Trace Control under Allocation. 
Coupling Marker/Time 

1. Click the TDR/TDT tab. 

2. Click on the desired check box in Trace Control under Coupling. 

Selecting Marker under Coupling enables all the marker on other traces to 
be moved in same alignment. 

Selecting Time under Coupling enables all other traces using the same X 
axis (Time). 

Copying Trace Setting 

1. Click on the Trace Settings Copy button. Trace Settings Copy dialog 
box appears. 

2. Select the source trace in the From list. Select the desired 
destination trace in the To list. 
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3. Click on the >> Copy >> button. 

Copied Parameter 

The following parameters  for the following functions are copied by the 
Trace Settings Copy. 

Functions SCPI Commands 

Parameter, Time Domain/S-Parameter, 
Single-Ended/Differential 

CALC:TRAC:PAR  

Format CALC:TRAC:FORM 

Marker CALC:TRAC:AMAR:ACT  

Peeling CALC:TRAC:CONV:PEEL:STAT  

Delta Time Dialog 
CALC:TRAC:DTIM:POS  

CALC:TRAC:DTIM:STAT  

Delta Time Target [Target is trace for 
stop] 

CALC:TRAC:DTIM:TARG 

Gating Start CALC:TRAC:GATE:STAR 

Gating State CALC:TRAC:GATE:STAT 

Gating Stop CALC:TRAC:GATE:STOP  

Gating Type CALC:TRAC:GATE:TYPE  

Marker Search [ON/OFF], marker [0-9, 
ref] 

CALC:TRAC:MARK[1-
10]:FUNC:TRAC  

Marker Search [MIN/MAX], marker [0-9, 
ref] 

CALC:TRAC:MARK[1-
10]:FUNC:TYPE  

Reference Marker [ON/OFF] CALC:TRAC:MARK[1-10]:REF:STAT  

Marker CALC:TRAC:MARK[1-10]:STAT  

Marker [x-axis value]  CALC:TRAC:MARK[1-10]:X  

Smoothing CALC:TRAC:SMO:STAT  

Impulse Width Value for Lowpass 
Impulse 

CALC:TRAC:TIME:IMP:WIDT  

Rise Time (for all traces) CALC:TRAC:TIME:STEP:RTIM:DATA  
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CALC:TRAC:TIME:STEP:RTIM:THR  

Stimulus CALC:TRAC:TIME:STIM  

Search Rise Time 
CALC:TRAC:TTIM:STAT  

CALC:TRAC:TTIM:THR  

Horizontal Scale DISP:TRAC:X:SCAL:PDIV  

Horizontal Position DISP:TRAC:X:SCAL:RLEV  

Vertical Scale DISP:TRAC:Y:SCAL:PDIV  

Vertical Position DISP:TRAC:Y:SCAL:RLEV  
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Hot TDR Measurement 

 Overview 

 Checking Device Malfunction 

 Reducing Measurement Error 

Other topics about Making Measurement 
Overview 

Hot TDR refers to TDR measurement while the device is powered ON. 
During measurement, the measurement signal is applied from the E5071C 
to the transmitter. However, this may cause device malfunction. In 
addition, the transmittor signal from the DUT device into the E5071C ports 
may cause measurement error. When you measure Hot TDR, the 
transmitter should be connected with Port 1 for Single END, Port1/2 for 
differential. 

 
Checking Device Malfunction 

The following procedure checks if the Signal Source level from the E5071C 
does not affect the device operation: 

1. Measure the reflection on the E5071C. 

2. Save the results in memory trace. 

3. Reduce the signal source level of the E5071C at Source Power. 

4. Check for significant change on the trace. If the change is significant, 
reduce the signal source level further to avoid device malfunction. 

Reducing Measurement Error 

The following procedure reduces the measurement error produced by the 
device signal. 

Case 1 (For Periodical Bit Pattern) 

If the output signal from device is periodic, set the data rate and execute 
"Avoid Spurious". This will reduce error due to spurious: 
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1. Click Setup tab and select Hot TDR. 

2. At the Data Rate, left-click once. An Entry dialog box appears. Type 
the data rate value and click OK. The new value is displayed at Data 
Rate. The Data Rate accuracy should be within ±0.5%. 

3. Click Avoid Spurious to execute the option. ENA searches for spurious 
and changes the stimulus setting to avoid the spurious. If the Avoid 
Spurious is successfully executed, a check mark appears next the 
Avoid Spurious button. At this point, measurement mode is changed 
from TDR/TDT to Hot TDR Mode and this is indicated at the channel 
window as "TDR ?". The blue SVC indicator is also turned ON. 

 Eye/Mask option tab is disabled in HOT TDR mode.  

 To reset the HOT TDR mode, simply execute preset 
or change the DUT toplogy. 

Case 2 (For Random Data) 

If the output signal from device is random, increase averaging to reduce 
the measurement error.  

About Avoid Spurious 

If Avoid Spurious fails, the "Spurious Not Found" warning message is 
displayed. Check mark next to the Avoid Spurious button will not be 
displayed.  

When the following parameter is changed, Avoid Spurious option should be 
executed again: 

 Data Rate 

 DUT Length 

 Deskew 

The setting of Avoid Spurious cannot be stored. To recall the condition of 
Avoid Spurious, you must execute the Avoid Spurious again after recalling 
the status setting.  

At the execution of Avoid Spurious: 

 If the IF bandwidth is over 10 kHz, the IF bandwidth value will be set 
at 10 kHz.  

 If the source power is over -20 dBm, the source power will be set at 
-20 dBm. 
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Eye Diagram and Mask Test 
Eye Diagram and Mask Test (Eye/Mask Tab) 

 Performing Eye Diagram Measurements 

 Selecting Bit Pattern 

 Using Mask Test 

 Available Masks 

Other topics about Enhanced Time Domain Analysis 
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Performing Eye Diagram Measurements 

 Overview 

 Showing Eye Diagram 

 Displaying Results 

 Scaling the Eye Diagram 

 Injecting Jitter 

Other topics about Eye Diagram and Mask Test 
Overview 

In the oscilloscope, an eye diagram is often used to analyze signal quality. 
You can diagnose problems, such as attenuation, noise, jitter, and 
dispersion that arise or characterize specific parts of the system with one 
display. 

The E5071C option TDR provides simulated eye diagram analysis 
capability, eliminating the need for a hardware pulse pattern generator. 
The virtual bit pattern generator is used to define a virtual bit pattern. The 
defined bit pattern is then convolved with the device impulse response to 
create an extremely accurate measurement based eye diagram. 

Showing Eye Diagram 

1. Select the trace number which you want to observe the eye diagram. 

2. Click Draw Eye to display the eye diagram. 

3. Whenever you change the setting of data pattern, it is required to 
click Draw Eye to reflect the setting on the waveform. 

Displaying Results 

1. Select Rise Time Def under Results. 

2. Click Draw Eye to display the result. 
Whenever you change the setting of Rise Time Def, it is required to 
click Draw Eye  to reflect on the result. 

The following results are displayed on the table under Results. 

Name Unit Description 

Rise Time Second 

Rise Time Def=10%-90%: Time at 90% level - Time at 
10% level 

Rise Time Def=20%-80%: Time at 80% level - Time at 
20% level 

Fall Time Second 

Rise Time Def=10%-90%: Time at 90% level - Time at 
10% level 

Rise Time Def=20%-80%: Time at 80% level - Time at 
20% level 
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Jitter RMS Second 1σ width of the histogram at the eye crossing point  

Jitter p-p Second Full width of histogram at the eye crossing point 

Crossing 
Percentage 

% Crossing Height / Amplitude × 100 

Opening Factor None (Level One -  σ one) - (Level Zero +  σ zero)  / Amplitude 

Signal/Noise 
Ratio 

None 

(Level One - Level Zero)/( σ one+  σ zero) 

 

Duty Cycle 
Distortion Second |T rise middle - T fall middle| 

Duty Cycle 
Distortion (%) 

% Duty Cycle Distortion (s)/ Bit period × 100 

Level Zero Voltage Histogram mean for level zero 

Level One Voltage Histogram mean for level one 

Level Mean Voltage (Level Zero + Level One) / 2 

Amplitude Voltage Level One - Level Zero  

Height Voltage (Level One - 3 σ one) - (Level Zero + 3 σ zero)  
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Width Second Bit Period  - 2 × 3 × Jitter RMS 

 Bit Period = 1/Bit Rate 

 Input Amplitude = Setting of Level One - Setting of Level Zero 

 T rise middle  = The time at which the rising edge cross the middle threshold (50%) 

 T fall middle  = The time at which the falling edge cross the middle threshold (50%) 

Overlaying the results on the waveform 

1. Select the Overlay check box under Result. 

2. The following results are displayed on the screen. 

 Jitter p-p, Level Zero, Level One, Amplitude, Height (V), Width 

Saving Results into File  

You can save the results as text file. 

1. Click Export to Csv, the Save Eye Result dialog box is displayed. 

2. Type your desired file name, then click Save. 

Example of Result 

# E5071C ENA Option TDR Simulated Eye Results 

# 7/1/2010 3:10:06 PM 

#  

Level Zero, 0.00337131636124 

Level One, 0.392246236818 

Level Mean, 0.19780877659 

Amplitude, 0.388874920457 

Height, 0.372870737968 
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Width, 9.94598885146E-10 

Opening Factor, 0.986281636548 

Signal / Noise, 72.894992429 

Duty Cycle Distortion, 6.12868274149E-14 

Duty Cycle Distortion (%), 0.00612868274149 

Rise Time, 4.69421997336E-11 

Fall Time, 4.69412762334E-11 

Jitter (PP), 6.25E-12 

Jitter (RMS), 9.00185809062E-13 

Cross Point (%), 49.9268781576 

  
Scaling The Eye Diagram 

By default, the eye diagram is set to Auto Scale. You can also set the scale 
manually. 

1. Click on Scale/Mask. 

2. Select the Manual radio button. This will activate the Scale / Div and 
Offset options. 

3. Click the entry box Scale / Div and input the Y axis scale value. 

4. Click the entry box for Offset and input the Y axis offset value. 

Mask Pattern 

See Using Mask Test for more information. 
Injecting Jitter 

See Using Jitter Injection for more information. 
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Selecting Bit Pattern 

 Overview 

 Bit Pattern Type 

 Settings Parameters of Bit Stream 

Other topics about Eye Diagram and Mask Test 
Overview 

E5071C-TDR can provides simulated eye diagram analysis capability, 
eliminating the need for a hardware pulse pattern generator. The virtual bit 
pattern can be selected from: 

 Pseudo-Random Bit Sequence 

 K 28.5 

 User Custom 

 Statistical 
Bit Pattern Type 

The following Bit Patterns can be used to develop an Eye Diagram: 

Bit 
Pattern 

Description 

PRBS    

Pseudo-Random Bit Sequence. An industry standard created from a 
specified pattern length. For example, when 2^7 is selected, 127 
[(2^7) -1] unique data 'words' are assembled according to the industry 
standard.   

K 28.5 
Industry standard developed by IBM which includes comma (control) 
characters. The pattern is "00111110101100000101" (20 bits). 

User Bit Patterns that you have created. 

Statistical 

Bit Patterns produced via statistical calculations of jitter specification 
When this option is selected, eye diagram is displayed as "Statistical" 
type. When Jitter Injection is turned ON, this option is set as the default 
selection. Refer to Using Jitter Injection. 

In the user bit pattern, you can set the same bit pattern as the Pseudo-
Random Bit Sequence. However you can get much better resolution in 
result when you use PRBS. 

Selecting Bit Pattern 

1. Select the Eye/Mask Tab. 

2. Select your desired bit pattern at Type under Bit Pattern. 



E5071C 

694 

3. If you select the PRBS option, length is activated. Then, select length 
under Bit Pattern. 

Using a User Bit Pattern 

You can easily create user (custom) bit patterns. The length of bit should 
be from 2 to 32768 (2^15).  The pattern with only either 0 or 1 can not be 
accepted (ex. 00, 111, 0000). 

Defining/Saving User Bit Pattern 

1. Select the Eye/Mask Tab. 

2. Select User at Type under Bit Pattern, then User Pattern is activated. 

3. Click User Pattern, then Bit Pattern Editor is displayed. 

4. Type "0" or "1" to create your bit pattern. 

5. Click OK, then the Save Bit Pattern Dialog box is displayed. 

6. Type your desired file name, then click Save. 

 Saving pattern to the file must be required when you use 
the user pattern. 

Recalling User Bit Pattern 

1. Select the Eye/Mask Tab. 

2. Click User Pattern, then Bit Pattern Editor is displayed. 

3. Click Load, then Load Bit Pattern Dialog box is displayed. 

4. Select your desired file name, then click Open. 

5. Click Ok to exit Bit Pattern Editor. 
Settings Parameters of Bit Stream 

The following parameter can be set for the bit stream. 

Label Description 

One 
Lv. 

Eye Diagram Y-axis scaling for bit "1" in volts. Negative voltages are 
allowed. For Differential Eye Diagrams, these scale values are doubled. 

Zero 
Lv. 

Eye Diagram Y-axis scaling for bit "0" in volts. Negative voltages are 
allowed. For Differential Eye Diagrams, these scale values are doubled. 

Data 
Rate  

The speed in bits/second which data is transferred over a circuit or a 
communications line. 

Rise 
Time 

The time that it takes a signal to transition from a low to a high condition. 
Maximum value is 40% of Bit width (Bit width =1/Bit Rate). The time can 
be defined by either "10-90%" or "20-80%". The rise time settings in 
EYE/MASK mode and TDR/TDT mode are independent. 
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Defining the parameters 

1. Select the Eye/Mask Tab. 

2. Click the text box of desired parameter under Stimulus, then the 
Entry dialog box is displayed. 

3. Type your desired number by clicking numeric keys on the Entry 
dialog box. 
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Using Mask Test 

 Overview 

 Defining Mask 

 Executing Mask Test 

Other topics about Eye Diagram and Mask Test 
Overview 

The mask test allows you to verify that a displayed waveform complies 
with industry-standards definitions for electrical waveforms. To comply 
with the industry standard, the input waveform must remain outside the 
shaded mask regions. The mask testing is available in Scale/Mask under 
the Eye/Mask tab. The E5071C-TDR uses the same format as Infiniium DCA 
(86100C), therefore, you can use the MASK file (.msk) stored by DCA 
(86100C). 

The some masks with industry-standards definitions are available in the 
E5071C directories. 

Defining Mask 

Opening Mask File 

 

Items Description 

File Name 
Shows the file name and location which is currently selected. The pre-
defined files and templates files are available under C:\Program 
Files\Agilent\E5070\TimeDomain\Masks.  
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File Name Description 

Template_Deca.msk Decagon shape eye mask (10 points) 

Template_Hexa.msk Hexagon shape eye mask (6 points) 

Template_Octa.msk Octagon shape eye mask (8 points) 

Template_Recta.msk Rectangular shape eye mask (4 points)  
 

Type 

Shows the Mask File Identifier. In case of Infiniium DCA, this identifier 
should be "MASK_FILE_861XX". However, the E5071C does not care of 
this. Even if this is other than "MASK_FILE_861XX", the E5071C 
accepts it.  
As the pre-installed MASK files are compatible with Infiniium DCA, 
"MASK_FILE_861XX" is displayed when you use pre-installed MASK 
files. It is not possible to change this in the Mask Pattern Dialog box. 

Description 
Shows the description of MASK file. You can change this in the Mask 
Pattern Dialog box. 

  

Loading Mask File 

1. Select the Eye/Mask tab. 

2. Click Mask Pattern under Scale/Mask, then the Mask Pattern Dialog box 
is displayed. 

3. Select the File tab. 

4. Click Load , then the Load Mask Pattern Dialog box is displayed. 

5. Select your desired mask file, then click Open. 

 When the following message prompts, define the values of the 
Logic 1 Lv and Logic 0 Lv in the scale tab and save the file. 
 

 
6. Click Close to exit the Mask Pattern Dialog box. 

The pre-defined files are read-only file. As you cannot overwrite on them, 
save the file by clicking Save As. 

Scaling Mask 
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Parameters Description 

Margin (%) 
Set the size of the mask margin. Mask margins are used to 
determine the margin of compliance for a standard or scaled mask 

Position (s) Move X-axis location of mask 

Delta T (s) Change X-axis width of mask 

Logic 1 Lv 
(V) Change voltage of logical 1.  

Logic 0 Lv 
(V) 

Change voltage of logical 0 

  

Changing Margin, Position, Delta T and Logic 0/1 Lv 

1. Load the Mask Pattern.   

2. Select the Scale tab. 

3. Change the margin number using slider, or typing number. 

4. Click the box at your desired parameter of position, delta T and logic 
0/1 level. 

5. Type the number you want to set. 

6. Click Update to apply the entered number. 

7. Click Close > Yes to save the modified scale. 

Set Value at Default 
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Click Default Scale to set the parameter at default. 

Editing Mask 

 

Parameter Description 

Region 
The currently selected region number.  The region number defines a 
mask violation area (or polygon). 

Point 
The currently selected point number. The point number defines a 
point in the region. 

X (s) and Y 
(V) 

The X and positions for the selected point. You can enter the 
number to change the selected position location. 

Std.X and 
Std.Y 

The X and Y positions when Margin in Scale Tab is selected at 0%. 
This shows the positions of STD in the .msk file. 

Max.X and 
Max.Y 

The X and Y positions when Margin in Scale Tab is selected at 
100%. This shows the positions of MARGIN_MAX in the .msk file.  

Min.X and 
Min.Y 

The X and Y positions when Margin in Scale Tab is selected at -
100%. This shows the positions of MARGIN_MIN in the .msk file.  

1. Load the Mask Pattern.  

2. Select the Edit tab. 

3. Move the position of points by either way. 

 Using Mouse 
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1. Click the desired point on the figure of mask, then the 
point is selected (the point color becomes red). 

2. Move the point with drag and drop on the mouse to your 
desired position. 

 Entering Position 

1. Click desired point on the figure of mask, then the point 
is selected. 

2. Click entry box of X(s) under position, then type number 
for X axis. 

3. Click entry box of Y(V) under position, then type number 
for Y axis. 

4. Click Update to apply the entered number on the selected 
point. 

4. Click Close > Yes to save the modified pattern. 
Executing Mask Test 

1. Select the Mask Test check box under Scale/Mask. 

2. Click Draw Eye to redraw Eye pattern and Mask. 

3. The mask and pass/fail result is displayed on the screen. 
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Available Masks 

The following tables list the available standard masks files that you can 
use. The E5071C-TDR uses the same format as Infiniium DCA (86100C). 
 The following available masks are the same as ones stored in DCA and 
stored under C:\Program Files\Agilent\E5070\TimeDomain\Masks.  

 SDH/SONET 

 Fibre Channel 

 Ethernet 

 Infiniband 

 Serial ATA 

 XAUI 

 Electrical 

 G_984_2 

Other topics about Eye Diagram and Mask Test 

SDH/SONET 

File Name Standard 

STM000_OC1.msk STM0/OC1, 51.8 Mb/s 

STM001_OC3.msk STM1/OC3, 155.5 Mb/s 

STM004_OC12.msk STM4/OC12, 621.8 Mb/s 

STM008_OC24.msk STM8/OC24, 1244 Mb/s 

STM016_OC48.msk STM16/OC48, 2.488 Gb/s 

STM016_G.691_V2.0.msk STM16/G.691 

STM064_OC192.msk STM64/OC192, 9.953 Gb/s 

STM256_OC768.msk STM256/OC-768, 39.812 Gb/s 

STM64_OC192FEC_10_664.msk STM-64/OC-192 FEC, 10.664 Gb/s 

STM64_OC192FEC_10_709.msk STM-64/OC-192 FEC, 10.709 Gb/s 

STM64_OC192SuperFEC_12_5.msk STM-64/OC-192 Super FEC, 12.5 Gb/s 
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Fibre Channel 

File Name Standard 

FC0133.msk FC133, 133 Mb/s 

FC0266.msk FC266, 266 Mb/s 

FC0531.msk FC531, 531 Mb/s 

FC1063.msk 
FC1063, 1063 Mb/s (Revision 1 of the 
standard) 

FC1063_PI_R13_Dec01.msk 
FC1063, 1063 Mb/s (Revision as of Dec., 
2001) 

FC2125.msk 
FC2125, 2125 Mb/s (Revision 1 of the 
standard) 

FC2125_PI_R13_Dec01.msk 
FC2125, 2125 Mb/s (Revision as of Dec., 
2001) 

FC4250_PI_R13_Dec01.msk FC4250, 2350 Mb/s 

008.5000-FC-PI-4 Multimode.msk FC8.5 Gb/s Fibre Channel 

10xFiberChannel.msk 10X Fibre Channel, 10.51875 Gb/s 

010.51875-SFP+_Rx_C'_10GE.msk 10X Fibre Channel, SFP+Rx C' 

010.51875-SFP+_Tx_B_10GE.msk 10X Fibre Channel, SFP+Tx B 

010.51875-XFP_B'_10GE.msk 10X Fibre Channel, XFP B' 

010.51875-XFP_C'_10GE.msk 10X Fibre Channel, XFP C' 

Ethernet 

File Name Standard 

01xGbEthernet.msk GB Ethernet, 1250 Mb/s 

02xGbEthernet.msk 2XGB Ethernet, 2.500 Gb/s 

10GbE_9_953_May02.msk 10GB Ethernet, 9.953 Gb/s 

10GbEthernet_10_3125.msk 
10GB Ethernet, 10.3125 Gb/s (Revision 
1 of the standard) 

10GbE_10_3125_May02.msk 
10GB Ethernet, 10.3125 Gb/s (Revision 
as of May, 2002)  

10_G_Base_LRM_May_2006.msk 10G BASE LRM, 10 Gb/s 
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10xGbEthernet_12_5.msk 10XGB Ethernet, 12.5 Gb/s 

1000BASE-LX10_September_2004.msk 1000BASE-LX10, 1.25 Gb/s 

100BASE-BX10_September_2004.msk 100BASE-BX10_September_2004.msk 

100BASE-BX_LX10.msk 100BASE-LX10, 100 Mb/s 

100BASE-BX_LX10.msk 100BASE-BX_LX10.msk 

10GBASE-LX4.msk 10BASE-LX4 

010.3125-SFP+_Rx_C'_10GE.msk 10.3125 Gb Ethernet SFP+ Rx C' 

010.3125-SFP+_Tx_B_10GE.msk 10.3125 Gb Ethernet SFP+ Tx B 

010.3125-XFP_B'_10GE.msk 10.3125 Gb Ethernet XFP B' 

010.3125-XFP_C'_10GE.msk 10.3125 Gb Ethernet XFP C' 

Infiniband 

File Name Standard 

InfiniBand_Jun01.msk 2.500 Gb/s 

Serial ATA 

File Name Standard 

SATA 1.5Gb TX 250 Cycles.msk SATA TX 250 Cycles, 1.5 Gb/s 

SATA 1.5Gb TX 5 Cycles.msk SATA TX 5 Cycles, 1.5 Gb/s 

XAUI 

File Name Standard 

XAUI-E_Far_May02.msk XAUI-E Far 

XAUI-E_Near_May02.msk XAUI-E Near 

Electrical 

File Name Standard 

STS1Eye.msk STS1Eye, 51.8 Mb/s  

STS3Eye.msk STS3Eye, 155.5 Mb/s 
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G.984.2 

File Name Standard 

2488.32_G.984.2_Downstream_March_2003.msk 2488.32 Mb/s ONU 

1244.16_G.984.2_Downstream_March_2003.msk 

1244.16_G.984.2_UpStream_March_2003.msk 
1244.16 Mb/s ONU 

622.08_G.984.2_Upstream_March_2003.msk 622.08 Mb/s ONU 

155.52_G.984.2_Upstream_March_2003.msk 155.52 Mb/s ONU 
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Storing Data and Setting 
Storing Data and Setting 

 Saving/Recalling Setting 

 Saving Data 

 Saving Touchstone Data 

 Saving Displayed Image 

Other topics about Enhanced Time Domain Analysis 
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Saving/Recalling Setting 

 Saving Setting 

 Recalling Setting 

 Compatibility of State Files 

Other topics about Storing Data and Setting 
Saving Setting 

The setting of E5071C-TDR can be saved and recalled. The state file of TDR 
measurements has .tdr file extension. 

1. Setup your configuration which you want to save. 

2. Click File in the tool bar. 

3. Select Save State from menu, then the Save State As Dialog Box is 
displayed. 

4. Type desired file name. 

5. Click Save. 

When you use 2-channel measurement in the Advanced Mode, the channel 
2 setting is also saved into .tdr file. 

Recalling Setting 

1. Click File in the tool bar. 

2. Select Recall State from menu, then the Recall State As Dialog Box is 
displayed. 

3. Select the file name of state file whose file extension is .tdr. 

4. Click Open. 
Compatibility of State Files 

Compatibility between Mode 

The following table shows the compatibility of state file between mode. 

Mode 

Recalling 

Basic 

Advanced 

Without 
Advanced 
Calibration 
Methods 

With 
Advanced 
Calibration 
Methods 

Saved 
File 
By 

Basic Y Y N 

Advanced 
Without 
Advanced 
Calibration 

N Y N 
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Methods 

With 
Advanced 
Calibration 
Methods 

N N Y 

Y: Recall is possible. 

N: Recall is impossible. 
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Saving Data 

The trace data can be saved in .csv format. 

1. Select the trace which you want to get the data. 

2. Click File in the tool bar. 

3. Select Save Trace Data from menu, then the Save Trace As Dialog Box 
is displayed. 

4. Type desired file name. 

5. Click Save. 

Example of File 

# Channel 1  

# Trace 4  

Frequency  Formatted Data  Formatted Data 

8.49E+06 -5.84E-02 0.00E+00 

1.70E+07 -8.27E-02 0.00E+00 

2.55E+07 -1.04E-01 0.00E+00 

3.40E+07 -1.32E-01 0.00E+00 

4.25E+07 -1.52E-01 0.00E+00 

5.09E+07 -1.84E-01 0.00E+00 

5.94E+07 -2.18E-01 0.00E+00 

6.79E+07 -2.70E-01 0.00E+00 

. 

(data is continued until the end) 

. 

Other topics about Storing Data and Setting 
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Saving Touchstone Data 

 File Extension 

 Saving Touchstone Data 

Other topics about Storing Data and Setting 
File Extension (SnP Format) 

The SnP file format is changed depending on the selected DUT topology. 

File Extension DUT Topology 

.s1p Single Ended 1 

.s2p Single Ended 2, Differential 1 

.s4p Single Ended 4, Differential 2 

See the Saving data in Touchstone format for touch stone format. 
Saving Touchstone Data 

The trace data can be saved in touch stone format.  

1. Click File in the tool bar. 

2. Select Save Touchstone from menu, then the Save Touchstone As 
Dialog Box is displayed. 

3. Type desired file name. 

4. Click Save. 

You can not create touchstone files in the following conditions. 

 # is displayed at Channel Measurement Status. 

 Some cases in Advanced Mode with Advanced Calibration Method  
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Saving Displayed Image 

 Saving Image 

 Inverting Display Color 

Other topics about Storing Data and Setting 
Saving Image 

The screen image can be saved in bit map or png format. 

1. Click File in the tool bar. 

2. Select Save Image from menu, then the Save Image As Dialog Box is 
displayed. 

3. Select the file type in Save as Type from either .bmp or .png. 

4. Type desired file name. 

5. Click Save. 
Inverting Display Color 

Inverting display color changes the background color of the screen from 
black to white. When you print out the saved image on a white paper, the 
background in white color saves a printer ink. 

1. Click File in the tool bar. 

2. Select Invert Color from menu, then the background color of the 
screen is changed from black and white.  

3. Save the screen by following the procedure of Saving Image. 
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Advanced Waveform Analysis 
Advanced Waveform Analysis 

 Overview 

 Using Jitter Injection 

 Using Emphasis 

 Using De-embedding 

 Using Equalization 

Other topics about Enhanced Time Domain Analysis 
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Overview 

In Advanced Waveform Analysis, emphasis and equalization helps to 
improve the quality of the waveform and subsequently the quality of the 
eye diagram.  

 
There are two options to display the advance waveform window: 

 Click on Adv Waveform under Setup tab and click one of these 
buttons: Emphasis, De-embedding, Equalization. 

 Click on Advanced Waveform button under the Eye/Mask tab 
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View radio button allows you to select the observation point for TDR/TDT or 
Eye, according to your selection. Changing View also affects the trigger 
mode: 

 View before the DUT shows the Stimulus View. At this view, trigger 
mode at the tool bar changes to "STOP".  

 View after the DUT shows the Response View. At this view, trigger 
mode changes to "RUN".   

 When Stimulus View is selected and the trigger mode 
"RUN/Single" is selected, the view changes to Response View. 

  

Other topics about Advanced Waveform Analysis 
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Using Jitter Injection 

 
1. To execute jitter injection, click on Jitter button and check Enable.  

2. When Jitter Injection is turned ON, check mark appears on the Jitter 
button. The Stimulus Type (under Eye/Mask tab) is automatically 
changed to "Statistical". 

 See also Bit Pattern Type. 

There are two types of jitter injection available to choose from: 

 Random Jitter - follows the Gaussian distribution and is represented 
by the rms value of the Random Jitter distribution.  

 Periodic Jitter - represented by peak-to-peak value. 

 
In general, Deterministic Jitter and Random Jitter totals up to Total Jitter 
(TJ). Deterministic Jitter is bounded by a finite magnitude. It can be 
broken into jitter which is correlated to the data sequence and jitter that 
occurs independent of data. Periodic Jitter is data independent. 
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Jitter Unit: You can select from Unit Interval (UI) or Second. Second = Unit 
Interval / Data Rate  

Display Limit: This is a probability density limit. Normally, it is not 
necessary to change this from default setting. This function allows you to 
execute a fine tuning of skirt of eye diagram. This applied to eye mask 
result. So that, you can have the same result on the mask test by 
adjusting this value. This is not applied to the eye result.  

Other topics about Advanced Waveform Analysis 
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Using Emphasis 

 
1. To execute emphasis, click on Emphasis button and check Enable.  

2. Cursor Level: 

 Pre cursor is the ratio between Vc and Vb2: 

Pre Cursor = 20 Log10 (Vc/Vb2) 

 Post 1 cursor is the  ratio between Vb1 and Va: 

Post 1 Cursor = 20 Log10 (Vb1/Va) 

 Post 2 cursor is the ratio between  Vb2 and Vb1: 

Post 2 Cursor = 20 Log10 (Vb2/Vb1) 

 When the emphasis is turned on, the DUT length 
should be larger than (1/Data Rate) × 3. The following graph 
shows the Data Rate vs. minimum DUT length for each 
frequency model. 
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Other topics about Advanced Waveform Analysis 
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Using De-embedding 

 
1. To execute de-embedding, click on De-embedding button and check 

Enable.  

2. If differential topology is selected, load S4P or S2P file. For single 
ended topology, load S2P file. 

3. You can enable each SnP file by checking Enable in Select De-
embedding file.  

4. The port orientation is shown and it defers depending on the DUT 
topology.  

Other topics about Advanced Waveform Analysis 
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Using Equalization 

 
To execute equalization, click on Equalization button and check Enable.  

You can either select to use the equation by specifying the variables or 
equation file.  

You must specify four variables in this equation in order to generate the 
filter. These variables are: 

 DC Gain  

 Zero Frequency 

 Pole 1 

 Pole 2 

Example of Equalization File 

!Agilent Technologies 

!E5071C Option ENA-TDR Equalization File 

# Hz dB 

1000000000,-1.53E+01,-3.27E-01 

2000000000,-1.52E+01,-7.34E+01 

3000000000,-1.03E+01,-8.63E+01 

4000000000,-9.88E+00,-1.00E+02 

------------------------------------- 

! Comment 

# Hz MA or DB or RI 

Freq1, Data1a, Data1b 

Freq2, Data2a. Data2b 

Freq3, Data3a, Data3b 
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. 

. 

Where  

MA: Dataxa = Magnitude (Linear), Dataxb = Phase 

DB: Dataxa = Magnitude (dB), Dataxb = Phase 

RI: Dataxa = Real, Dataxb = Image 

   

 If there is no Dataxb, Dataxb is taken as 0. 

 If there is no MA/DB/RI, MA is selected. 

 ! (comment) can be place at any lines (Not only top lines but also in 
the middle). 

 If  Freq n > Freq (n+1), then the data at freq (n+1) is ignored.  

 If frequency span of setting on the E5071C is wider than frequency 
range of data, the extrapolation is applied. 

Error Messages 

 File Name Error: is the same as ENA error. This message appears 
when an error exists in the file name and hence a command is not 
executed correctly.  

 Failed To Read Error. This message appears when the file cannot be 
opened or if the file does not exist. It also occurs when the format of 
the file is incorrect or the number of data line is less than 2 or more 
than 10001. 

Other topics about Advanced Waveform Analysis 
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Advanced Mode 
Advanced Mode 

 Overview 

 Activating and Deactivating Advanced Mode 

 Frequently Used Functions in Advanced Mode (ENA Standard 
Functions) 

Other topics about Enhanced Time Domain Analysis 
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Overview 

 Feature 

 Consideration in Advanced Mode 

Other topics about Advanced Mode 
Feature 

The following table shows the comparison of Advanced and Basic Modes. 

Mode Feature 

TDR 
Applicatio
n (User 
Interface) 

Hard 
Key on 
Front 
Panel 

Soft 
Key 
(right 
sideof 
the 
screen
) 

Indicators 

Advance
d 

 Customized 
TDR/S-
parameter 
measureme
nts in TDR 
(Ch1) 
 
Such as: 

o More 
Marker 
Functions 

o Limit Test 
o TRL 

Calibratio
n 

o Two 
channel 
measure
ments 
(Ch1 for 
TDR/Ch2 
for 
Network 
Measurem
ent) 

Available 
Availabl
e 

Availabl
e 

TDR 
indicator: 
Yellow 

In 
Instrument 
status bar, 
 SVC: Blue 
(the 
measuremen
t 
performance 
is not 
guaranteed) 

Basic Easy of use Available 

Locked 
excepts 
Trace 
Prev, 
Trace 
Next, 
Trace 
Max and 

Hidden 

TDR 
indicator: 
Blue 

  

In 
Instrument 
status bar, 
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keys in 
numeric 
key. 

 SVC: 
Normal 

The sample measurements are shown in the measurement examples. 
Consideration in Advanced Mode 

In the Advanced Mode, you can access all setting of E5071C. The setting 
you changed may affect the measurement unexpectedly. The 
measurement may not be correct if you have such a case.  Therefore, the 
measurement performance is not guaranteed in the Advanced Mode. 

It is known that changing the following setting causes incorrect 
measurement. 

Hard key Do not use 

Meas 

When Use Advanced Calibration Mode is not checked: 

Single end 1 port: Parameters related with ports 2, 3 and 4  
Single end 2 port/Differential 1 port: Parameters related with ports 
3 and 4  

Display Data Math, Equation Editor  

Calibration  When Use Advanced Calibration Mode is not checked: All 

Sweep Setup 

Start/Stop/Center/Span 

Points 

Sweep Type 

Frequency Offset 

Marker 
Function 

Marker -> Start, Marker -> Stop 

System  Measurements with Multi-port Test Set (E5091A/E5092A) 

Here is another caution in the Advanced Mode. 

Function Note 

Meas 
Change parameter 
when Port extension on 

This may cause to tilt the wave form in the 
time domain . Use TDR GUI to select 
parameter. 

Display 
Increasing Num of 
Trace 

This may cause to tilt the wave form in the 
time domain. 

Analysis 
Fixture Simulator 

This may cause to tilt the wave form in the 
time domain. 

Transform > Window > 
Impulse width or Step 

The range of these settings is narrower than 
one of the Rise Time in the TDR GUI. Use 
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Rise TDR GUI to set the rise time. 

Calibration 
Increasing Port 
Extension 

This may cause to exceed the DUT length 
limitation. 

Scale 
Increasing Electrical 
Delay 

This may cause to exceed the DUT length 
limitation. 

Ave IF Bandwidth 
Even if you have narrow IF Bandwidth, you 
may not have noise reduction at lower 
frequency. 
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Activating and Deactivating Advanced Mode 

 Activating Advanced Mode 

 Deactivating Advanced Mode 

Other topics about Advanced Mode 
Activating Advanced Mode 

1. Select the Setup tab. 

2. Click Advanced Mode under More Function, then Advanced Mode 
dialog box is displayed.  

3. When you want to perform a calibration such as TRL calibration in 
Advanced Mode, select the check box named Use Advanced 
Calibration Methods in dialog box. 

 When you select the check box, the calibration you 
did in basic mode is cleared.  

4. Click Yes to start the Advanced Mode. 

5. The following settings are changed. 

 Softkeys are displayed on the right side of screen  

 All hard keys are unlocked. 

 SVC in the instrument status bar turns in blue. 
Deactivating Advanced Mode (Returning to Basic Mode) 

1. Select the Setup tab. 

2. Click Basic Mode button under More Function, then Advanced Mode 
dialog box is displayed.  

3. Click Yes to start the Basic Mode. 

4. E5071C application is re-started and all setting has been reset. 
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Frequently Used Functions in Advanced Mode (E5071C Standard Functions) 

 For Channel 1 

 For Channel 2 

Other topics about Advanced Mode 

This section provides the links with the E5071C standard function. 
For Channel 1 

As the channel 1 is for TDR measurement, you can use some of 
functionality of E5071C standard function. 

 Cal (Mechanical, ECal, TRL) (Only when Use Advanced Calibration 
Mode) 

 Marker Search 

 Limit Test 
For Channel 2 

As the channel 2 can be used as one channel of E5071C, You can use all of 
functionality of E5071C. 

 Measurement Parameter  

 Single-ended & Differential 

 Format  

 Scale 

 Display Allocation  

 IFBW 

 Cal (Mechanical, ECal, TRL) 

 Stimulus 

 Power 

 NOP 

 Sweep Type 

 Segment Sweep 

 Trigger 

 Marker, Marker Search, Marker Function 

 Limit Test 

 Port Z conversion 

 De-embedding 

 Save/Recall 

 Save data (csv, snp) 
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Measurement Example 
Measurement Examples 

 PCB Impedance Measurement (Advanced Mode Example) 

 2 Channel Measurement Example (Advanced Mode - 2 Channel 
Example) 
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PCB Impedance Measurement 

Measuring the characteristic impedance of single-ended transmission line 
within a defined zone. 

 
Ensure E5071C-TDR application is in Advanced Mode in order to follow this 
example. 

Before beginning to make measurement on PCB impedance, we need: 

1. Set Measurement Conditions 

2. Define Measurement Zone 

3. Set Measurement Zone and Measure Characteristic Impedance 

Other topics about Measurement Examples 
Set Measurement Conditions 

1. Click Setup > Setup Wizard. 

2. Select Deskew and click Next. 

3. Select Single Ended 1-Port and click Next. 

4. Follow the instruction and click Deskew. When finish, click Next. 

5. Follow the instructions and click Measure. When finish, click Next.  

6. Click Apply and Finish. 
Define Measurement Zone 

Using E5071C-TDR application GUI, 

1. Disconnect the DUT. 

2. Click Trace > 1 and double-click on the trace. 

3. Click TDR/TDT > Parameters > Linear (under Format). 

4. Click AutoScale > X & Y to adjust timebase for the entire response of 
the DUT is visible. 

5. Click Marker > 1. 
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Using Softkey (on the right side of the screen), 

6. Click Marker Search > Target > Target Value. 

7. Type 0.5 target value into the entry box. This steps locate the instant 
t1 on the TDR waveform where the open discontinuity occurs. 

8. Connect the DUT. 

Using E5071C-TDR application GUI, 

9. Click Marker > 2. 

Using Softkey (on the right side of the screen), 

10. Click Marker Search > Target > Target Value. 

11. Type 0.5 target value into the entry box. This steps locate the 
instant t2 on the TDR waveform where the open discontinuity occurs. 

Calculate the measurement zone using the formulas below. 

Compute the round trip propagation time of the transmission line: 

Trt = t2 -t1 = 1.68 ns - 0 = 1.68 ns (refer to the figure below) 

Determine the initial instant, ti, of the measurement zone: 

ti = t1 + 30%Trt = 0 + (0.3)×1.68 ns = 0.50 ns 

Determine the final instant, tf, of the measurement zone: 

tf = t1 + 70%Trt = 0 + (0.7)×1.68 ns = 1.18 ns 
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Set Measurement Zone and Measure Characteristic Impedance 

1. Click TDR/TDT > Parameters > Impedance (Under Format). 

2. Click TDR/TDT. Type in 25 into scale/div (left) entry box under 
Vertical. 

3. Click TDR/TDT. Type in -75 into position (right) entry box under 
Vertical. 

Using Softkey, 

4. Click Marker Search > Search Range > Start. Type in 0.5 ns in the 
entry box. 

5. Click Marker Search > Search Range > Stop. Type in 1.18 ns in the 
entry box. 

6. Click Marker Search > Search Range > Search Range to enable search 
range. 

7. Click Marker Function > Statistics to enable statistics and measure the 
characteristic impedance. 
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The characteristic impedance is the mean value, 52.15 U. 
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2 Channel Measurement Example 

 Overview 

 Procedure 

Other topics about Measurement Examples 
Overview 

This sample shows a 2 channel measurement in the Advanced Mode. 

2 Channel measurement allows you to make measurements: 

 TDR measurement on channel 1 

 More customized S-parameter measurement on channel 2 

Here is the sequence of this sample. 

 Setup for channel 1 

1. Deskew 

2. Auto DUT length 

3. Set rise time  

4. Setup limit table for the trace 1 

 Setup for channel 2 

1. Setup start and stop frequency and IF Bandwidth. 

2. Setup Sdd11 of Balance-Balance measurement 

3. Setup limit table for the trace 1 

4. Full 4-port calibration with ECal 

 Measurement for channel 1 

1. Trigger 

2. Auto scale 

 Measurement for channel 2 

1. Trigger 
Procedure 

Preparation for 2 Channel Measurement 

1. Connect E-Cal on the USB port on the front panel. 

2. Connect cables to all test ports. 

3. Activate Advanced Mode (Do not select the Use Advanced Calibration 
Method check box) 

4. Click Stop Single to stop the trigger. 
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Using Hardkey/Softkey 

1. Press Display > Allocate Channel >  to have 2 channels. 

2. Press Trigger > Trigger Scope to select Active Channel. 

3. Press System > Misc Setup > Beeper > Beep Waning to turn off the 
beep warning. 

Setup for Channel 1 

1. Click the Setup tab on the GUI. 

2. Click the Setup Wizard (under Basic) at Setup area. 

3. Set the measurement condition using the Setup Wizard: 

a. Select Deskew  (under Error Correction) and click Next >. 

b. Click the Differential 2-Port button, and click Next >. 

c. Click the Deskew button, and click Next >. 

d. Click the Measure button, and click Next >. 

e. Set the Rise Time to "50 ps" and select "20-80%" from the 
Definition drop-down list. When finish, click Apply to save the 
settings. 

f. Click the Finish button. 

Limit Test Setup 

Using Hardkey/Softkey 

1. Select Trace 1 with either  Trace Next/Trace Prev or Trace on the tool 
bar of the GUI. 

2. Press Analysis > Limit Test > Limit Test  to turn on the limit test. 

3. Click Limit Line to turn on. 

4. Click Edit Limit Line, then limit table is displayed. 

5. Edit the table as shown below, then click Return. 

  Type 
Begin 

Stimulus 
End 

Stimulus 
Begin 

Response 
End 

Response 

1 MAX 0 s 1 ns 105 U 105 u 

2 MIN 0 s 1 ns 75 U 75 U 

Setup for Channel 2 

1. Press Channel Next  to select the channel 2. 

2. Press Start, then type 1G to set the start frequency at 1GHz. 
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3. Press Stop, then type 3G to set the start frequency at 3 GHz. 

4. Press Avg > IF Bandwidth, then type 10k to set the IF bandwidth 
frequency at 10 kHz. 

5. Press Analysis > Fixture Simulator > Fixture Simulator to turn ON. 

6. Click Topology > Device > Bal-Bal, then click Return. 

7. Click BalUn to turn ON. 

8. Click Measurement > Sdd21. 

Full 4-port Calibration  

1. Connect 4 Port Ecal with the cables. 

2. Press Cal > Ecal > 4-Port Cal. 

See Full 4-Port Calibration if you use the mechanical calibration kit. 

Limit Test Setup 

Using Hardkey/Softkey 

1. Press Analysis > Limit Test > Limit Test  to turn on the limit test. 

2. Click Limit Line to turn on. 

3. Click Edit Limit Line, then limit table is displayed. 

4. Edit the table as shown below, then click Return. 

  Type 
Begin 

Stimulus 
End 

Stimulus 
Begin 

Response 
End 

Response 

1 MIN 100 MHz 1.25 GHz -1.5 dB -5 dB 

2 MIN 1.25 GHz 2.5 GHz -5 dB -7.5 dB 

3 MIN 2.5 GHz 7.5 GHz -7.5 dB -25 dB 

Measurement for Channel 1 

1. Connect the DUT with the cables.  

2. Click Stop Single to make one single measurement. 

3. Select Trace 1 with either  Trace Next/Trace Prev or Trace on the tool 
bar of the GUI. 

4. Click Auto Scale (tool bar), then select All Traces. 

Measurement for Channel 2 

1. Press Channel Next to select the channel 2. 

2. Press Trigger > Single  to make one single measurement. 
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Time Domain Analysis 

Time Domain Analysis 

 Overview 

 Characteristics of Response in Time Domain 

 Deleting Unnecessary Data in Time Domain (Gating) 

 Transformation to Time Domain 

Other topics about Measurement with Options 

  

  

  



E5071C 

736 

Overview of time domain measurement 

 Overview 

 Comparison to Time Domain Reflectometry (TDR) Measurement 

 Time Domain Function of E5071C 

Other topics about Time Domain Analysis 

Overview 

The E5071C Option 010 provides the time domain function, which is used 
to mathematically transform waveforms in the frequency domain that can 
be measured with a general network analyzer to waveforms in the time 
domain. 

The following figure shows waveforms in the frequency domain and in the 
time domain when using the same cable. The waveform in the frequency 
domain shows ripples due to mismatches, but it is difficult to estimate their 
locations. On the other hand, from the waveform in the time domain, you 
can determine the locations and magnitudes of mismatches. 

 
Comparison to Time Domain Reflectometry (TDR) Measurement 
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The time domain function of the E5071C is similar to the time domain 
reflectometry (TDR) measurement in that it displays the response in the 
time domain. 

In the TDR measurement, a pulse or step signal is inputted to the DUT and 
the change of the reflected wave over time is measured. 

On the other hand, the time domain function of the E5071C changes the 
frequency of the input signal to the DUT, performs measurement in the 
frequency domain, and transforms the result to the response in the time 
domain using the inverse Fourier transform. 

Time Domain Function of E5071C 

The time domain function of the E5071C is divided into the following two 
types of functions. You can use them at the same time. 

Transformation function 

Transforms measurement data in the frequency domain to data in the time 
domain. For more information, refer to Transformation to time domain. 

Gating function 

Deletes unnecessary data in the time domain from original data in the time 
domain. For more information, refer to Deleting Unnecessary Data in Time 
Domain (gating). 
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Characteristics of Response in Time Domain 

 Overview 

 Masking 

 Mismatch Type 

Other topics about Time Domain Analysis 

Overview 

This section describes masking and the identification of the mismatch type, 
which are important for analyzing the response in the time domain. 

Masking 

Masking is a phenomenon in which a mismatch at a location near the 
calibration surface affects the response at the next mismatch location. This 
occurs because energy reflected by a mismatch at the location nearest to 
the calibration surface does not reach the next mismatch location. For 
example, when you measure the reflection of a cable that has 2 mismatch 
locations reflecting 50% of the input voltage, the first mismatch reflects 
50% of the measurement signal. The remaining 50% reaches the next 
mismatch and its 50%, which is 25% of the entire measurement signal, is 
reflected. Therefore, in the response in the time domain, the second 
mismatch looks smaller. 

 In this example, the transmission line is assumed to have no 
loss. However, because there actually is loss, the signal is attenuated as 
the distance from the calibration surface becomes greater. 

The following figure shows an example of masking due to loss. It compares 
masking when a short termination is directly connected to the calibration 
surface and masking when a 6-dB attenuator is inserted. In either case, 
total reflection occurs at the short termination. In the latter case, the 
signal is attenuated in both ways, and the return loss appears to be - 12 
dB. 

Example of masking 
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Mismatch Type 

The transformation in the low pass mode simulates the response in the 
TDR measurement. In addition to mismatch locations, the response 
includes information on the mismatch type. 

The following shows each mismatch type and the response waveform 
corresponding to it. In the low pass mode, you can simulate the response 
of the step signal and the impulse signal. From the viewpoint of 
mathematics, the response of the impulse signal is the waveform obtained 
by differentiating the response of the step signal. 
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Deleting Unnecessary Data in Time Domain (gating) 

 Measurement Flow 

 Setting Gate Type 

 Setting Gate Shape 

 Setting Gate Range 

 Enabling Gating Function 

Other topics about Time Domain Analysis 

Measurement Flow 

Item Description 

1. Measurement in 
frequency domain 

Executes measurement in frequency domain 

2. Transformation to 
time domain 

Enables transformation function and transforms measurement 
data to data in time domain 

3. Setting the gate Makes the following settings of the gate to select the 
necessary domain: 

 Gate type 

 Gate shape 

 Gate range 

4. Transformation 
back to frequency 
domain 

Disables transformation function and displays response in 
frequency domain corresponding to the data selected with the 
gate 

  

The following figure shows the change in the waveform at each step of the 
flow. 
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Setting Gate Type 

The E5071C lets you choose from the following two gate types: 

Gate type Description 

Band pass Deletes response outside the gate range 

Notch Deletes response inside the gate range 
Operational procedure 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to set the gate type. 

2. Press Analysis key, then click Gating to display the Gating menu. 

3. Click Type to toggle between band pass (Bandpass) and notch 
(Notch). 

Setting Gate Shape 

The gate is a filter whose shape looks like a band pass filter. There are 
several parameters that indicate the gate shape. The following figure 
shows the definition of the gate shape parameters. 
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The following table compares the characteristics according to the gate 
shape. When the shape is "minimum," the cutoff time is shorter and the 
response is deleted abruptly, but the sidelobe level and band pass ripples 
become larger. When it is "maximum," cutoff is gentler, but the sidelobe 
level and the band pass ripple become smaller. The minimum gate span in 
the following table is the minimum gate range you can set. This value is 
defined as the minimum gate span necessary for the existence of the pass 
band and is equal to 2 times the cutoff time. 

Gate 
shape 

Passband 
ripple 

Sidelobe 
level 

Cutoff time Minimum gate 
span 

Minimum ± 0.13 dB - 48 dB 1.4/frequency 
span 

2.8/frequency 
span 

Normal ± 0.01 dB - 68 dB 2.8/frequency 
span 

5.6/frequency 
span 

Wide ± 0.01 dB - 57 dB 4.4/frequency 
span 

8.8/frequency 
span 

Maximum ± 0.01 dB - 70 dB 12.7/frequency 
span 

25.4/frequency 
span 

Operational procedure 

1. Press  Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate a trace for which you want to set the gate shape. 

2. Press Analysis key, then click Gating to display the Gating menu. 
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3. Press Shape and then select the gate shape. 

Setting Gate Range 

Specify the gate range in time. The ends of the range are defined as the -
 6 dB attenuation points shown in the figure above. You can set the gate 
range by specifying the start and stop times or the center and span. The 
E5071C has the following limitations on the gate range you can set. 

Lower limit     -Tspan    

Upper limit     Tspan 

Tspan is the measurement range expressed in time obtained in 
Measurement range. 

Operational procedure 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to set the gate range. 

2. Press Analysis key, then click Gating to display the "Gating" menu. 

3. Press each of the following softkeys to specify the gate range. 
Distance corresponding to the setting time is displayed at the side of 
the set value area in the data entry bar. The displayed distance is a 
value that takes the velocity factor into consideration. 

Softkey Function 

Start Sets the start time 

Stop Sets the stop time 

Center Sets the center of the gate in time 

Span Sets the gate span in time 

 No Hardkey is provided for this setting. The hardkeys 
are dedicated to setting the sweep range. 

 You can set the center and span by dragging and 
dropping flags indicating the gate range. 

Enabling Gating Function 

When you enable the gating function, data within the specified range is 
deleted. When the transformation function is enabled, the flags indicating 
the gate range is displayed as shown in the following figure. 
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 In the figure, the gate type is set to band pass. 
When it is set to notch, the directions of the flags indicating the 
ends of the gate range are reversed. 

 
Operational procedure 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to use the gate function. 

2. Press Analysis key, then click Gating to display the "Gating" menu. 

3. Use Gating to enable (ON) the gate function. 
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Transformation to time domain 

 Overview 

 Measurement Flow 

Other topics about Time Domain Analysis 

Overview 

The transformation function lets you transform a response in the frequency 
domain to the corresponding response in the time domain. 

Measurement Flow 

Item Description 

Selecting a type 

Selects the transformation type from the following. 

Band pass mode 

You can set the sweep range arbitrarily. This is suitable 
for devices through which signals within a certain 
frequency range pass such as filters. 

Low pass mode 

Simulates the TDR measurement. This mode is suitable 
for devices through which dc current or signals of many 
frequencies pass, such as cables. 

The low pass mode provides two types of modes: low 
pass step and low pass impulse. 

Setting the window 
Sets the window to reduce the ringing phenomenon, in 
which a waveform's waves are caused due to the fact 
that the frequency domain is finite. 

Calculating necessary 
measurement conditions 

Calculates the following values to obtain the necessary 
resolution and measurement range in the time domain. 

Sweep range 

Number of points 

Window width 

Setting the frequency 
range and the number of 
points 

Sets the sweep range and the number of points to the 
values calculated above. 

Setting display range Sets the range displayed on the graph. 

Enabling transformation 
function 

Enables the transformation function. 

Selecting a type 
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There are two types of transformation to the time domain: band pass and 
low pass. The appropriate transformation type depends on the DUT. 

Comparison between band pass mode and low pass mode 

Item Band pass Low pass 

Appropriate 
DUT 

DUTs that do not operate with 
dc current such as band pass 
filters. 

DUTs that operate with dc 
current such as cables. 

Input signal You can simulate the response 
to the impulse signal. 

You can simulate the TDR 
measurement. You can simulate 
the response to both the 
impulse signal and step signal. 

Selection of the 
sweep range 

You can select the sweep 
range arbitrarily. 

Because dc data are estimated 
from the first few points, the 
frequencies of measurement 
points must be multiples of the 
start frequency. 

Transmission/ 

reflection 
measurement 

You can perform both 
transmission and reflection 
measurements. 

You can perform both 
transmission and reflection 
measurements. 

Identification of 
mismatches 

You can identify the locations 
of mismatches. 

You can identify the locations of 
mismatches and the type of 
impedance (capacitive or 
inductive). 

Resolution   The resolution in the time 
domain increases by two times 
over that in the band pass 
mode. 
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Available data 
format 

 Liner magnitude format 

 In the reflection 
measurement, it indicates 
the mean of the reflection 
coefficient within the 
frequency sweep range. 

 In the transmission 
measurement, it indicates 
the mean of the transmission 
coefficient within the 
frequency sweep range. 

 Log magnitude format 

 In the reflection 
measurement, it indicates 
the mean of the return loss 
within the frequency sweep 
range. 

 In the transmission 
measurement, it indicates 
the mean of the transmission 
gain within the frequency 
sweep range. 

 SWR format 

 In the reflection 
measurement, it indicates 
the mean of SWR (standing 
wave ratio) within the 
frequency sweep range. 

  

Real format 

In the low pass mode, the real 
format is useful because the 
time axis data do not have 
phase information. 

Impulse signal and step signal 

The E5071C lets you simulate the response from the DUT to two types of 
signals: impulse signal and step signal. The impulse signal is a pulse-shape 
signal in which the voltage rises from 0 to a certain value and returns to 0 
again. The pulse width depends on the frequency sweep range. The step 
signal is a signal in which the voltage rises from 0 to a certain value. The 
rise time depends on the maximum frequency within the frequency sweep 
range. 

 For more information on how the frequency span 
setting affects the pulse width and the rise time, refer to 
Calculating necessary measurement conditions. 

Step signal and impulse signal 
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Operation 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate a trace for which you want to set the transformation type. 

2. Press Analysis key, then click Transform to display the Transform 
menu. 

3. Type and then press one of the softkeys to specify the type. 

Softkey Function 

Bandpass Sets the transformation type to "band 
pass." 

Lowpass 
Step 

Sets the transformation type to "lowpass 
step." 

Lowpass 
Imp. 

Sets the transformation type to "lowpass 
impulse." 

4.   

5. Press Format key to display the "Format" menu and then select the 
data format. 

Setting the window 

Because the E5071C transforms data within a finite frequency domain to 
data in the time domain, an unnatural change of data at the end points 
within the frequency domain occurs. For this reason, the following 
phenomena occur. 
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 Width of impulse signal and rise time of step signal 
A time width occurs in the impulse signal and a rise time occurs in 
the step signal. 

 Sidelobe 
Sidelobes (small peaks around the maximum peak) occur in the 
impulse signal and the step signal. Ringing occurs on the trace due 
to sidelobes, which reduces the dynamic range. 

By using the window function, you can lower the level of sidelobes. 
However, the width of the impulse and the rise time of the step become 
larger as a penalty. You can select from three types of windows: 
maximum, normal, and minimum. The following table shows the 
approximate relation between the window and the sidelobe/impulse width. 

Window Sidelobe 
level of 
impulse 
signal 

Width of 
impulse (50% 
in low pass 
mode) 

Sidelobe 
level of 
step 
signal 

Rise time of step 
signal (10 -
  90%) 

Minimum - 13 dB 0.60/frequency 
span 

- 21 dB 0.45/frequency 
span 

Normal - 44 dB 0.98/frequency 
span 

- 60 dB 0.99/frequency 
span 

Maximum - 75 dB 1.39/frequency 
span 

- 70 dB 1.466/frequency 
span 

  

The window function is available only when the response in the time 
domain is displayed. It does not have any effect when the response in 
frequency domain is displayed. The following figure shows the effect of the 
window when measuring the reflection of a short circuit in the time 
domain. 

 
  

Operation 
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1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate a trace for which you want to set the window. 

2. Press Analysis key, then click Transform to display the Transform 
menu. 

3. Press Window and then select a window type. 
  

Softkey Function 

Maximum Sets the window type to maximum. b  of the Kaiser Bessel 
function is set to 13. 

Normal Sets the window type to normal. b  of the Kaiser Bessel function is 
set to 6. 

Minimum Sets the window type to minimum. b  of the Kaiser Bessel function 
is set to 0. 

Rise Time Sets the window by specifying the impulse width or the step rise 
time. The lower limit can be set to the value when the window is 
the minimum, the upper limit when the window is the maximum. 

Kaiser 
Beta 

Sets the window by specifying the b  value of the Kaiser Bessel 
function. The Kaiser Bessel function determines the shape of the 
window. The allowable setting range is 0 to 13. 

 By specifying Kaiser Beta, Impulse Width, or Rise 
Time, you can specify a window that is not classified into the 
three window types. Conversely, when you specify a window 
type, these values are set automatically. 

Calculating necessary measurement conditions 

To use the transformation function efficiently, you need to make the 
following three settings appropriately. 

 Resolution of the response 

 Measurement range 

 Sidelobe 

This section describes the details of these settings. 
Effect of frequency sweep range on response resolution 

The following figure shows an example when measuring the same cable 
while changing the sweep span. When measured in a narrower sweep 
range, the overlap between two peaks is larger than when measured in a 
wider sweep range. By performing measurement in a wider sweep range, 
adjacent peaks can be clearly separated, which means that the response 
resolution is smaller. 
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Effect of frequency sweep range on resolution 

 
The sweep range affects the width of the impulse signal and the rise time 
of the step signal. The width of the impulse signal and the rise time of the 
step signal are inversely proportional to the sweep range. Therefore, the 
wider the sweep range is, the shorter these times are. 

The resolution is equal to the width defined at the point of 50% of the 
impulse signal or the rise time defined at the points of 10% and 90% of 
the step signal. 

Definitions of impulse width and step rise time 
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Effect of the window function on the response resolution 

Lowering the sidelobe level with the window function elongates the width 
of the impulse signal and the rise time of the step signal. As described in 
Effect of frequency sweep range on response resolution, because the 
response resolution is equal to the width of the impulse signal and the rise 
time of the step signal, lowering the sidelobe level enlarges the response 
resolution. The following table shows the approximate relationship between 
the response resolution and the window setting. 

Correspondence of Window setting and response resolution 

Window Low pass step Low pass impulse Band pass 

Minimum 0.45/stop frequency  0.60/stop frequency 1.20/frequency span 

Normal 0.99/stop frequency 0.98/stop frequency 1.95/frequency span 

Maximum 1.46/stop frequency 1.39/stop frequency 2.77/frequency span 

The following figure shows how the response changes as the window shape 
changes. If the magnitudes of adjacent peaks are comparable, you need to 
make the resolution higher; if they differ significantly, you need to set the 
window so that smaller peaks with lower sidelobes appear. 

Effect of window on response resolution 
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Effect of the transformation type on the response resolution 

Although both transformation types, band pass and low pass impulse, 
simulate the response of the impulse signal, the impulse width in the low 
pass impulse mode is half the width of that in the band pass mode as 
shown in the table above. Therefore, the resolution is better in the low 
pass mode. If the DUT can be measured in the low pass mode, response 
data with better resolution is obtained in the low pass mode. 

Measurement range 

In the time domain function, the measurement range means the range 
within which the response can be measured without repetition. The 
repetition of the response occurs because measurement in the frequency 
domain is performed discretely instead of continuously. The measurement 
range is inversely proportional to the frequency difference between 
adjacent measurement points. The frequency difference between 
measurement points Delta F is expressed as follows by using the span of 
the sweep frequency Fspan and the number of points  Nmeas. 
 

 
Therefore, the measurement range is proportional to the number of points-
1 and inversely proportional to the span of the sweep range. To enlarge 
the measurement range, use one of the following methods: 

 Increase the number of points. 

 Narrow the span of the sweep range. 

 When you change the above settings after performing 
calibration, you need to perform calibration again. 

The sweep range is expressed as time or distance. The time of the 
measurement range  Tspanis as follows: 
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The distance of the measurement range Lspan is expressed as follows 
using the velocity factor V and the speed of light in a vacuum c (3*E8 m/s). 
 

 
 The maximum length of the DUT that can be 

measured in the transmission measurement is Lspan. On the 
other hand, in the reflection measurement, bemcause the signal 
goes and returns, it is 1/2 of Lspan. 

The velocity factor varies depending on the material through which the 
signal propagates: 0.66 for polyethylene and 0.7 for PTFE. 

Changes in the settings and the changes in the response 

The following table shows the effect of changes in the measurement 
conditions on the response resolution and the measurement range. 

Change in setting Response 
resolution 

Measurement 
range 

Sidelobe 

Widening the sweep 
range 

Becomes smaller Becomes narrower Does not 
change 

Setting the window type 
to maximum 

Becomes larger Does not change Becomes 
lower 

Increasing the number 
of points 

Does not change Becomes wider Does not 
change 

Setting the frequency range and the number of points 
Operation 

1. Press Channel Next/Channel Prev keys to activate the channel you 
want to set.  The frequency range and the number of points are 
common to all of the traces in the channel. If you want to use 
different settings, make them on another channel. 

2. Press Sweep Setup key, then press Sweep Type > Lin Freq to set the 
sweep type to linear sweep.  When the sweep type is set to other 
than the linear sweep, the time domain function is not available. 

3. Set the sweep range using the Start/Stop or Center/Span keys. 

4. Press Sweep Setup key, then press Points and then enter the number 
of points. When performing measurement in the low pass mode, 
press Analysis > Transform > Set Freq Low Pass to adjust the 
frequency range so that it is appropriate for the low pass mode. The 
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frequency changes depending on the stop frequency as shown below. 
  

Condition of stop frequency Frequency setting 

>= Flow * the number of points Start frequency = stop 
frequency/number of points 

< Flow * the number of points Start frequency: Flow 

Stop frequency = Flow * Number of points 

5. Flow =9 kHz or 100 KHz (Depending upon the installed option) 

When the frequency settings satisfy the conditions shown above, the Set 
Freq Low Pass key is displayed in gray. 

Setting display range 

The E5071C has the following limitations on the display range you can set. 

 Lower limit: -Tspan 

 Upper limit: Tspan 

Tspan is the measurement range expressed in time obtained in 
Measurement range. 

The number of response points displayed on the graph is the same as the 
number of points regardless of the response resolution. 

Operation 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev to 
activate the trace for which you want to set the display range. 

2. Press Analysis key, then click Transform to display the "Transform" 
menu. 

3. Press each of the following softkeys and then specify the display 
range. Distance corresponding to the setting time is displayed at the 
side of the set value in the data entry bar. The displayed distance is 
a value taking the velocity factor into consideration. 
  

Softkey Function 

Start Sets the start value of the display range in time 

Stop Sets the stop value of the display range in time 

Center Sets the center value of the display range in time 

Span Sets the span of the display range in time 
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 You cannot use hardkeys to set the display. The 
hardkeys are dedicated to specifying the sweep range. 

Enabling transformation function 
Operation 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev to 
 activate the trace for which you want to use the transformation 
type. 

2. Press Analysis key, then click Transform to display the "Transform" 
menu. 

3. Press Transform to enable (ON) the transformation function. 

4. The following requirements must be met to enable the 
transformation function. 

 The sweep mode is the linear sweep. 

 There are three or more measurement points. 

 


